Legal information

Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**
indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions.
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

**WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.
# Table of contents

1 Security information ............................................................................................................. 9

2 S7-PLCSIM overview ............................................................................................................ 11
   2.1 Introduction to S7-PLCSIM ............................................................................................ 11
   2.2 What's new in S7-PLCSIM V15? .................................................................................. 11
   2.3 A note about input values .............................................................................................. 12
   2.4 Installation setup, requirements, repair, and uninstallation ........................................ 12
      2.4.1 Simulating S7-300 and S7-400 PLCs ................................................................. 12
      2.4.2 Requirements for S7-PLCSIM installation ......................................................... 12
      2.4.3 S7-PLCSIM installation setup .............................................................................. 12
      2.4.4 Repairing and uninstalling S7-PLCSIM ............................................................... 13
   2.5 Differences between S7-PLCSIM products .................................................................. 13
   2.6 Supported hardware ..................................................................................................... 14
      2.6.1 Hardware support based on STEP 7 license ......................................................... 14
      2.6.2 Steps for recognizing hardware with upgraded firmware ..................................... 15
   2.7 S7-PLCSIM concepts ................................................................................................... 15
      2.7.1 Starting to work in S7-PLCSIM ............................................................................. 15
      2.7.2 Compact view and Project view ............................................................................. 15
         2.7.2.1 Starting in S7-PLCSIM in Project view or Compact view ............................... 15
         2.7.2.2 Switching between Compact view and Project view ..................................... 16
      2.7.3 Working with simulations and projects .................................................................. 16
      2.7.4 Starting and stopping a simulation......................................................................... 17
      2.7.4.1 Starting and stopping a simulation .................................................................... 17
      2.7.4.2 Simulation and the power button ................................................................. 18
      2.7.4.3 Changing the CPU family being simulated ................................................. 19
      2.7.5 Simulation states .................................................................................................... 21
      2.7.6 Supported STEP 7 programs for simulation ........................................................... 22
      2.7.7 RUN and STOP modes and simulation ................................................................. 22
      2.7.8 Differences between a simulated PLC and a "real" PLC ........................................ 22
         2.7.8.1 Overview of differences ................................................................................. 22
         2.7.8.2 Differences common to all supported PLCs ................................................ 23
         2.7.8.3 Differences specific to S7-1200 PLCs .......................................................... 24
         2.7.8.4 Differences specific to S7-1500 PLCs .......................................................... 26
         2.7.8.5 Differences specific to ET 200SP PLCs ......................................................... 28
   2.8 Using the help system .................................................................................................. 31
      2.8.1 Overview of the help system ................................................................................ 31
      2.8.2 Searching the help system .................................................................................. 33
      2.8.3 Readme and Online Readme files ....................................................................... 33
# Table of contents

## 3 Startup options

3.1 Overview of startup options .......................................................... 35
3.2 Startup from TIA Portal ............................................................... 35
3.2.1 Overview of startup from the TIA Portal ............................ 35
3.2.2 Enabling simulation support .................................................. 35
3.2.3 Know-how protection and startup ....................................... 36
3.2.4 The Start simulation command ............................................ 36
3.3 Startup from desktop icon or start menu ............................... 37
3.3.1 Overview of starting from a desktop icon or start menu ...... 37
3.4 Startup from an existing S7-PLCSIM project ....................... 37
3.4.1 Overview of startup from an existing project .................. 37
3.4.2 Open a project by double-clicking the file name .............. 37
3.4.3 Open a project from main menu or main toolbar .......... 38
3.4.4 Opening an S7-PLCSIM V14 SP1 project ....................... 38
3.4.5 Opening a project created prior to V14 SP1 ..................... 38
3.4.6 Using an existing S7-PLCSIM project for simulation and debugging ...... 38

## 4 Modifying a running simulation

4.1 Overview of modifying a running simulation ....................... 39
4.2 Simulating a power cycle .......................................................... 40
4.3 Changing the CPU family being simulated ...................... 41
4.4 Configured versus unconfigured simulations ...................... 43

## 5 Working in Compact view

5.1 Overview of working in Compact view ................................. 45
5.2 Compact view user interface .................................................. 45
5.3 Using memory reset (MRES) in Compact view ................... 47

## 6 Working in Project view

6.1 Project view user interface ...................................................... 49
6.1.1 Project view user interface overview ............................... 49
6.1.2 The S7-PLCSIM menu bar ............................................... 50
6.1.2.1 S7-PLCSIM menu bar ........................................... 50
6.1.2.2 S7-PLCSIM menu bar commands .......................... 51
6.1.3 The S7-PLCSIM toolbar ................................................... 57
6.1.3.1 S7-PLCSIM toolbar ............................................. 57
6.1.3.2 S7-PLCSIM toolbar objects ................................. 58
6.1.4 Project tree description ...................................................... 61
6.1.5 Application settings .......................................................... 62
6.1.5.1 Overview of settings .............................................. 62
6.1.5.2 Application settings ................................................ 63
6.1.5.3 Start view ................................................................ 63
6.1.5.4 Reset to default ...................................................... 63
6.1.5.5 Storage settings ....................................................... 64
6.1.5.6 Cycle time settings .................................................. 64
6.1.5.7 Undo/redo in application settings ............................. 64
6.1.6 Managing the workspace ................................................. 65
6.1.7 Keyboard shortcuts ............................................................ 66
## Table of contents

6.2 Using Undo and Redo in Project view ................................................................. 68
  6.2.1 Overview of Undo and Redo................................................................. 68
  6.2.2 Clearing the Undo/Redo queue ......................................................... 69
  6.2.3 Interaction between Undo and Redo ................................................. 69
  6.2.4 Undo and Redo in the main Project view window ......................... 70
  6.2.5 Undo and Redo under Project view main menu > Options > Settings 71

6.3 Working with projects...................................................................................... 72

6.4 Project view: simulation and project states.................................................... 75
  6.4.1 Simulations and projects are separate actions........................................ 75
  6.4.2 Overview of project and simulation states ........................................... 75
  6.4.3 No open project and no running simulation ......................................... 76
  6.4.4 No open project and a running but unconfigured simulation ............. 77
  6.4.5 No open project with a configured simulation ..................................... 78
  6.4.6 Project is open with no running simulation ......................................... 79
  6.4.7 Project is open with a running but unconfigured simulation ............. 80
  6.4.8 Project is open with a running, configured simulation ...................... 81

6.5 Visual feedback regarding online and offline states ...................................... 82

6.6 Working in Device configuration view ............................................................ 82
  6.6.1 Overview of Device configuration view .............................................. 82
  6.6.2 Device configuration user interface ..................................................... 83
  6.6.3 Device configuration sections ............................................................. 84
  6.6.3.1 Configured hardware section ........................................................ 84
  6.6.3.2 Addresses section .......................................................................... 86
  6.6.4 Undo and Redo in Device configuration .............................................. 86
  6.6.5 Device configuration view before a STEP 7 download ................. 87
  6.6.6 Device configuration view after a STEP 7 download ....................... 87

6.7 Features common to both SIM table and Sequence editors .......................... 87
  6.7.1 Overview of common features ............................................................. 87
  6.7.2 Common clipboard actions ............................................................... 88
  6.7.3 Adding, editing, and deleting rows ..................................................... 89
  6.7.4 Applying tags for addresses .............................................................. 89
  6.7.5 Auto-completion for tags .................................................................. 90
  6.7.6 Common row indicators .................................................................... 91
  6.7.6.1 Overview of the common row indicators ................................. 91
  6.7.6.2 Error indicator ............................................................................. 91
  6.7.6.3 Force indicator ........................................................................... 91
  6.7.6.4 Fail-Safe indicator ...................................................................... 91

6.8 Working in the SIM table editor .......................................................... 92
  6.8.1 Overview of working in the SIM table editor .................................. 92
  6.8.2 SIM table editor description ............................................................ 93
  6.8.3 Creating and populating a SIM table ............................................... 96
  6.8.3.1 Overview of creating and populating a SIM table ...................... 96
  6.8.3.2 SIM table: load project tags from STEP 7 ............................... 97
  6.8.3.3 Using auto fill in the SIM table ................................................. 97
  6.8.3.4 Monitoring and modifying values in table view ....................... 98
  6.8.3.5 SIM table: copy and paste tags and tables from STEP 7 .......... 99
  6.8.3.6 SIM table: import and export using Microsoft Excel ............... 100
  6.8.3.7 Drag and drop a module from Device configuration to create a SIM table 102
  6.8.3.8 Creating a new sequence from recorded SIM table editor actions 103
Table of contents

6.8.4 Working with analog and digital values in control view ............................................................... 103
6.8.4.1 Overview of control view ........................................................................................................ 103
6.8.4.2 The Control view slider for analog values ............................................................................. 104
6.8.4.3 The Control view push button for Boolean values ................................................................. 105
6.8.5 SIM table error conditions ....................................................................................................... 106
6.9 Working in the Sequence editor .................................................................................................. 107
6.9.1 Overview of working in the Sequence editor ........................................................................... 107
6.9.2 Sequence editor description ..................................................................................................... 108
6.9.3 Breakpoint functionality .......................................................................................................... 112
6.9.4 Undo and Redo in the Sequence editor ..................................................................................... 113
6.9.5 Creating and populating a sequence ......................................................................................... 113
6.9.5.1 Overview of creating and populating a sequence ................................................................. 113
6.9.5.2 Working with a sequence created from a SIM table recording ............................................. 114
6.9.5.3 Sequence: using auto fill ...................................................................................................... 114
6.9.5.4 Sequence: copy and paste tags and tables from STEP 7 ...................................................... 115
6.9.5.5 Sequence: import and export using Microsoft Excel .......................................................... 115
6.9.5.6 Sequence: import from a STEP 7 trace ............................................................................... 116
6.9.5.7 Recording a sequence from SIM table actions ...................................................................... 121
6.9.6 Methods for starting a sequence ............................................................................................. 123
6.9.6.1 Sequence start action .......................................................................................................... 123
6.9.6.2 Repeating a sequence from the toolbar button ....................................................................... 124
6.9.6.3 Start a sequence with a trigger condition ............................................................................... 124
6.9.6.4 Repeating a sequence configured to trigger from a tag ........................................................ 126
6.9.6.5 Visual feedback while running a sequence .......................................................................... 127
6.9.7 Sequence actions and action parameters ............................................................................... 127
6.9.8 Time-related Sequence information ....................................................................................... 129
6.9.8.1 Sequence time entry ............................................................................................................ 129
6.9.8.2 Sequence step timing .......................................................................................................... 131
6.9.8.3 Edit execution time .............................................................................................................. 132
6.9.9 Inserting, adding, and deleting sequence steps ......................................................................... 134
6.9.10 Enable and disable sequence steps ....................................................................................... 136
6.9.11 Step time adjustment ............................................................................................................ 137
6.9.12 Running more than one sequence at a time .......................................................................... 137
6.9.13 Sequence error conditions ................................................................................................... 138
7 Simulating motion control ........................................................................................................... 139

7.1 Motion control overview ............................................................................................................ 139
7.2 Restrictions with motion control ............................................................................................... 140
7.2.1 Simulations and homing mode ............................................................................................... 140
7.2.2 Technology objects not loaded ............................................................................................. 140
7.2.3 Maximum of 5,120 motion control resources ........................................................................ 140
7.2.4 Wait briefly after going to RUN mode to access motion control technology objects .......... 140
7.2.5 Motion OB overruns .............................................................................................................. 141
7.2.6 Upgraded projects containing blocks OB91 and OB92 ........................................................ 141
7.2.7 Simulation deactivates MC-PreServo and MC-PostServo ...................................................... 141
7.2.8 TO_PositioningAxis ............................................................................................................... 141
7.2.9 TO_ExternalEncoder .............................................................................................................. 142
7.2.10 High Speed Counter ............................................................................................................ 142
7.2.11 High Speed Counter functionality for S7-1500C (compact) PLCs ..................................... 142
7.2.12 Isochronous mode not possible error ................................................................................... 142
# Table of contents

## 8 Simulating communication
- Overview of simulating communication .......................................................... 143
- Running multiple concurrent simulations ......................................................... 144
- Supported communication instructions between PLC families .................. 144

## 9 Error conditions and limitations
- Overview ........................................................................................................ 149
- Specific error conditions and limitations ......................................................... 149
  - Yellow coloring for Fail-Safe IO ................................................................. 149
  - Scan cycle overflow .................................................................................. 149
  - Incompatible diagnostic status for simulated S7-1500 PLCs with firmware version 1.8 ... 149
  - Simulating HMI connections ................................................................... 150
  - HMI Accessible tags ................................................................................ 150
  - Compile error after attempting to download to S7-PLCSIM ...................... 151
  - "Cut" performs a "Copy" between S7-PLCSIM instances .......................... 151
  - Simulating communication with an HMI and multiple PLCs ................. 152
  - Avoid forcing inputs when simulating S7-1500 ....................................... 152
  - Simulating Fail-Safe programs ................................................................. 152
  - Use STEP 7 safety system library v1.3 or later for Fail-Safe IO ................... 152
  - Working with global libraries ................................................................... 152
  - Valid range for Sequence "Set to frequency" values .................................. 153
  - Incorrect RET_Val parameter values for S7-1500 EN_AIRT and DIS_AIRT instructions that are called from multiple OBs ................................................................. 153
  - Cyclic event overflow error ...................................................................... 153
  - HMI password protection levels and simulation ........................................ 153
  - STEP 7 online & diagnostics functions ..................................................... 154
  - Simulation during standby mode ............................................................... 154
  - Running S7-PLCSIM on a remote desktop connection ............................ 154
  - Working with automatically synchronized network drives ..................... 155
  - Project menu delay .................................................................................. 155
  - Mnemonics selection ............................................................................... 155

Index ............................................................................................................. 157
Siemens provides products and solutions with industrial security functions that support the secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial security concept. Siemens' products and solutions constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems, machines and networks. Such systems, machines and components should only be connected to an enterprise network or the internet if and to the extent such a connection is necessary and only when appropriate security measures (e.g. firewalls and/or network segmentation) are in place.

For additional information on industrial security measures that may be implemented, please visit [https://www.industry.siemens.com/topics/global/en/industrial-security/Pages/default.aspx](https://www.industry.siemens.com/topics/global/en/industrial-security/Pages/default.aspx).

Siemens' products and solutions undergo continuous development to make them more secure. Siemens strongly recommends that product updates are applied as soon as they are available and that the latest product versions are used. Use of product versions that are no longer supported, and failure to apply the latest updates may increase customers' exposure to cyber threats.

2.1 Introduction to S7-PLCSIM

The focus of S7-PLCSIM is to support debugging and validating a single PLC program without requiring actual hardware. S7-PLCSIM allows you to use all STEP 7 debugging tools, including the watch table, program status, online & diagnostics functions, and other tools.

S7-PLCSIM also provides tools that are unique to S7-PLCSIM, including a SIM table and sequence editor.

S7-PLCSIM operates in conjunction with STEP 7 in the TIA Portal. You can:
1. configure your PLC and any associated modules in STEP 7
2. program your application logic
3. download the hardware configuration and program to S7-PLCSIM in either compact view or project view

2.2 What's new in S7-PLCSIM V15?

New features in S7-PLCSIM V15

S7-PLCSIM V15 contains many useful new features and functions, including the following:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Topic</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-PLCSIM V15 and S7-PLCSIM Advanced can be installed on the same computer</td>
<td>Differences between S7-PLCSIM products [Page 13]</td>
</tr>
<tr>
<td>The S7-PLCSIM SIM table editor has a slider control for adjusting analog values</td>
<td>The Control view slider for analog values [Page 104]</td>
</tr>
<tr>
<td>The S7-PLCSIM SIM table editor has a push button control for adjusting Boolean values</td>
<td>The Control view push button for Boolean values [Page 106]</td>
</tr>
<tr>
<td>Simulation of know-how protected blocks for S7 1500 and ET 200SP projects</td>
<td>Know-how protection and startup [Page 36]</td>
</tr>
<tr>
<td>Clicking &quot;start simulation&quot; in TIA Portal prompts you to enable simulation for your S7 1500 and ET 200SP project</td>
<td>Enabling simulation support [Page 35]</td>
</tr>
<tr>
<td>S7-PLCSIM supports breakpoints for S7 1500 and ET 200SP CPUs in your STEP 7 program</td>
<td>Breakpoint functionality [Page 112]</td>
</tr>
</tbody>
</table>
2.3 A note about input values

Input area values from the S7-PLCSIM Project view SIM table editor and sequence editor are equivalent to physical inputs on a "real" CPU. These are the values that will be copied to the process image at the start of each scan cycle.

2.4 Installation setup, requirements, repair, and uninstallation

2.4.1 Simulating S7-300 and S7-400 PLCs

You must use S7-PLCSIM V5.4.x to simulate S7-300 and S7-400 PLCs. If you want to simulate these PLCs using TIA Portal V15, you must first install S7-PLCSIM V15. Installing S7-PLCSIM V15 automatically installs S7-PLCSIM V5.4.8.

2.4.2 Requirements for S7-PLCSIM installation

You must meet the following requirements before you install S7-PLCSIM V15.

Use a supported operating system

S7-PLCSIM V15 supports the same set of operating systems as the TIA Portal V15. Refer to the Readme section of the TIA Portal online help for the definitive list of supported operating systems.

If you have already installed TIA Portal V15 successfully, S7-PLCSIM V15 should install correctly.

2.4.3 S7-PLCSIM installation setup

S7-PLCSIM V15 has its own setup independent of the TIA Portal V15.

S7-PLCSIM must be installed manually. It is not automatically installed as part of the TIA Portal setup process.

Multiple versions of S7-PLCSIM can be installed on the same computer without interference. This is the same behavior as the TIA Portal, where multiple versions of the software (V14 and V15, for example) can be installed on the same computer.

When you install S7-PLCSIM V15, S7-PLCSIM V5.4.8 is also installed.
2.4.4 Repairing and uninstalling S7-PLCSIM

Since S7-PLCSIM is installed software, it will appear in the installed programs area of the Microsoft Windows Control Panel. Click the "S7-PLCSIM V15" entry and then choose to uninstall or to modify (repair).

You can repair or uninstall S7-PLCSIM V15 without affecting other installed versions of S7-PLCSIM or any other installed SIMATIC software.

2.5 Differences between S7-PLCSIM products

There are several products with "S7-PLCSIM" in the title.

S7-PLCSIM V15 (this product)

Your STEP 7 license type determines which families of SIMATIC CPUs you can simulate with S7-PLCSIM V15.

With a STEP 7 Basic license you can simulate the following CPU families:
- S7-1200
- S7-1200F

With a STEP 7 Professional license you can simulate the following CPU families:
- S7-1200
- S7-1200F
- S7-1500
- S7-1500F
- ET 200SP
- ET 200SPF

S7-PLCSIM V5.4.8

S7-PLCSIM V5.4.8 supports simulation for the following SIMATIC CPU families:
- S7-300
- S7-300F
- S7-400
- S7-400F

S7-PLCSIM V15 and S7-PLCSIM V5.4.8 are separate software applications. You can install and run both of them on the same machine at the same time. Therefore you can simulate communication using this combination of applications.
S7-PLCSIM Advanced V2.0

You can install S7-PLCSIM V15 and S7-PLCSIM Advanced V2.0 on the same machine. Even though you can install S7-PLCSIM V15 and S7-PLCSIM Advanced V2.0 on the same machine, you can only run one of these applications at a time. Therefore, you cannot simulate communication using this combination of applications.

If the S7-PLCSIM V15 installer detects an S7-PLCSIM Advanced V1.0, the S7-PLCSIM V15 installation is aborted. Similar behavior also occurs with the S7-PLCSIM Advanced V2.0 installer. If S7-PLCSIM Advanced V2.0 detects the existence of S7-PLCSIM V14 or older, S7-PLCSIM Advanced V2.0 aborts installation.

2.6 Supported hardware

2.6.1 Hardware support based on STEP 7 license

Your STEP 7 license determines which CPUs you can simulate with S7-PLCSIM.

STEP 7 Basic and S7-PLCSIM

With a TIA Portal Basic license, you can simulate the following CPU families in S7-PLCSIM:

- S7-1200 with firmware version 4.0 or higher
- S7-1200F with firmware version 4.1 or higher

If your project contains CPUs with older firmware versions, the "Start simulation" button in TIA Portal is not selectable and you cannot start a simulation.

You can start and run two S7-1200 or S7-1200F simulations at the same time with any combination from these two CPU families.

TIA Portal Basic does not support the following CPU families:

- S7-1500 and S7-1500F
- ET 200SP and ET 200SPF

STEP 7 Professional and S7-PLCSIM

With a TIA Portal Professional license, you can simulate any of the following CPU families:

- S7-1200 with firmware version 4.0 and higher
- S7-1200F with firmware version 4.1 and higher
- S7-1500 and S7-1500F with any firmware version
- ET 200SP and ET 200SPF with any firmware version

You can start and run two simulations at the same time with any combination of these CPUs.
2.6.2 Steps for recognizing hardware with upgraded firmware

If you have installed or updated a device's firmware in the TIA Portal using a hardware support package (HSP), those devices might not appear in the Device configuration.

If you change the firmware version of your hardware and then attempt to use an existing S7-PLCSIM project, you will receive the error that loading to the target system is not possible.

You will receive this error if, for example, you have upgraded an S7-1500 CPU from firmware version 2.0 to firmware version 2.6 and then attempt to use a project you created for an S7-1500 version 2.0.

2.7 S7-PLCSIM concepts

2.7.1 Starting to work in S7-PLCSIM

The user interface for S7-PLCSIM consists of two main views: Compact view and Project view.

You can choose to start work in either Compact view or in Project view based on how you intend to use S7-PLCSIM.

2.7.2 Compact view and Project view

2.7.2.1 Starting in S7-PLCSIM in Project view or Compact view

Compact view

Compact view consists of one small main window with a limited number of controls and functionality. S7-PLCSIM launches very quickly when you start with Compact view.

This view will be useful to you if you want to debug your program within STEP 7 rather than in S7-PLCSIM. Compact view uses only a small part of your PC desktop, allowing you to debug your program in STEP 7 while having S7-PLCSIM open at the same time.

S7-PLCSIM launches in Compact view by default. If you want to make Project view the default view, you can make this change in the Project view main menu under Options > Settings.
Project view

Project view contains the full functionality of S7-PLCSIM. Project view has much the same look and feel as the user interface of the TIA Portal.

When you launch in, or switch to, Project view, S7-PLCSIM starts more slowly than when you launch in Compact view. This is because S7-PLCSIM is incorporating the extra functionality of project view during the startup process.

Project view consists of several components:

- Main menu and main toolbar
- Options and settings (accessed from the main menu)
- Project tree
- Device configuration view
- SIM table editor
- Sequence editor

Project view will be useful to you if you prefer to debug your program using the full functionality of S7-PLCSIM, rather than performing debugging tasks in STEP 7.

2.7.2.2 Switching between Compact view and Project view

Regardless of which view you selected as the default, you can easily switch between Compact view and Project view at any time by using the "switch views" button.

What displays when you switch from one view to the other is dependent on the state of the application at the time you switch; for example, whether your simulation is configured or not, whether the simulation is running, whether you are working with an open project, and so forth.

For example, if you are currently in Compact view, you cannot create, save, or work directly with a project. Therefore, you would switch to Project view to perform any of those actions.

If you are currently in Project view, you might want to switch to Compact view so that S7-PLCSIM does not take up as much room on the computer screen, allowing you to work more efficiently in the TIA Portal.

2.7.3 Working with simulations and projects

Projects and simulations are not the same thing. You can have a project without starting or running a simulation, and you can run a simulation without creating or opening a project.

The following sections describe this concept in more detail.
2.7.4 Starting and stopping a simulation

2.7.4.1 Starting and stopping a simulation

S7-PLCSIM V15 has a power button 🛑 for starting and stopping a simulation.

Remember that beginning with S7-PLCSIM V15, starting and stopping a simulation is a separate task from creating or opening an S7-PLCSIM V15 project.

The power button is supported in both Compact view and Project view as shown in the screenshots below:

<table>
<thead>
<tr>
<th>Power button and CPU family selector in Compact view</th>
<th>Power button and CPU family selector in Project view</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Compact view screenshot]</td>
<td>![Project view screenshot]</td>
</tr>
</tbody>
</table>

To start a new simulation, select the correct CPU family from the drop-down list and then click the power button to launch the simulation.

While a simulation is running, the power button is green and the CPU family selector is disabled.

You can stop the running simulation by again clicking the power button.

Clicking the power button ends the current simulation. It is not the same as setting the simulation to "STOP" mode. When you click the power button it has the same functionality as turning off the power supply for a "real" PLC.

You can stop a simulation regardless of whether there is an open S7-PLCSIM project. If there is an open project and you are in Project view, the Project tree is updated to show this state. Stopping the simulation also causes Project view to go "offline". You will no longer be able to run SIM tables or sequences.

In Compact view, the visual changes are more subtle. The power button will be gray and the CPU family selector becomes visible.

There are two possible use cases for stopping a simulation:

- You want to simulate a power cycle operation
- You want to change the CPU family being simulated
2.7.4.2 Simulation and the power button

The power button is available in both Compact view and Project view. You use the power button to turn a simulation on or off.

The power button is green when a simulation is running, whether the simulation is configured or unconfigured.

The power button is gray when you are not running a simulation.

Examples of power button use

The screen capture below shows the Compact view with a running, configured S7-1500 simulation.

- the power button is green
- the configured CPU name is displayed
- the communications address is shown
- the LEDs are active
- the Run/Stop/MRES buttons are enabled

Clicking the power button (to turn off the simulation) results in the following.
Note what has (and has not) changed in the user interface:

- the power button is gray
- the configured CPU name is still displayed
- the communications address is removed
- the LEDs are disabled
- the RUN/STOP/MRES buttons are disabled
- the CPU family selection is visible

Your configuration is saved when you stop the simulation. If you click the power button again, the new simulation starts with the same configuration as when you stopped the simulation.

This has the effect of "power cycling" the previous simulation.

### 2.7.4.3 Changing the CPU family being simulated

One reason to power off a simulation is to change the CPU family you are simulating.

**Procedure for changing the CPU family**

Returning to the stopped simulation seen in the previous section:
The drop down list for CPU family is now visible. Click the down arrow to display the list of supported CPU families:

If you change CPU families and then click the power button, this starts a new, unconfigured simulation of the type you select and the current simulation is discarded. The Compact view appears as follows:

- the "unconfigured" CPU name is displayed
- no communications address is shown
- the LEDs and the Run/Stop/MRES buttons are disabled

In the Project view, if there is an open S7-PLCSIM project, changing the simulation family and starting a new simulation will cause the project tree to update to show the new, unconfigured simulation.
2.7.5 Simulation states

There are three possible simulation states:

- Unconfigured simulation
- Configured simulation
- No simulation

Unconfigured simulation

A simulation is considered to be unconfigured if you have selected a PLC family and clicked the power button to the "on" state, but have not yet performed a download for a specific PLC from STEP 7.

In this state, S7-PLCSIM displays the PLC name as "Unconfigured PLC".

An unconfigured simulation can be useful when you want to work with a certain PLC family environment but are not yet ready to work with a specific PLC.

Configured simulation

A simulation is considered to be configured after you have downloaded a specific PLC from STEP 7. In this case, the PLC name is displayed as, for example, "MyPLC [CPU 1215 DC/DC/DC]".

No simulation

S7-PLCSIM is considered to be in the "no simulation" state if the application is open but powered off. The power button is gray in this state.

If you are in the "no simulation" state, you can still create a project and set up your SIM tables and sequences in Project view.
2.7.6 **Supported STEP 7 programs for simulation**

S7-PLCSIM accepts the download of any valid program for a supported, configured CPU. With some exceptions (noted below), the downloaded program should go to RUN mode without changes.

There are three specific scenarios that require you to make changes to your STEP 7 program before you perform a download to S7-PLCSIM. Those are:

- **Know-how protection.** S7-PLCSIM supports simulation of programs with know-how protected blocks for S7-1500 and ET 200SP CPUs. It does not support simulation of programs with know-how protected blocks for S7-1200 CPUs. In order to simulate projects that contain know-how protected blocks, it is necessary that you first remove the protection from the block(s) before you download your project to S7-PLCSIM.

- **Fail-Safe programs.** S7-PLCSIM supports Fail-Safe program simulation. However, you might need to increase the F-cycle time because scan times for the simulation will be longer.

- **S7-1500 motion programs.** S7-PLCSIM supports the simulation of S7-1500 SMC (simple motion control) configurations. However, in order to successfully run these programs, you might need to increase the motion cycle time because scan times for the simulation will be longer.

2.7.7 **RUN and STOP modes and simulation**

The simulated PLC supports downloads while in RUN mode.

S7-PLCSIM writes output values when you put the simulated PLC in STOP mode.

2.7.8 **Differences between a simulated PLC and a "real" PLC**

2.7.8.1 **Overview of differences**

The virtual PLC is not fully able to simulate a real PLC. There might be differences in the behavior of the virtual PLC compared to a real PLC. Sometimes the differences apply to all CPU families, and other times to only one CPU family or specific CPU.

Many system CPU functions (SFCs and SFBs) have limited behavior for simulation. Programs that rely on this functionality behave differently during simulation.

Also, programs that are very dependent on timing might be difficult to debug with a simulation, since the simulation timing is not nearly as deterministic as timing for a real PLC.
2.7.8.2 Differences common to all supported PLCs

I/O device support

S7-PLCSIM does not support specialized IO module functionality. It provides only process image and direct access simulation of IO registers.

An example of how you can observe this specialized functionality is with analog output range monitoring. On a real module, if an out-of-range value is written to an analog output register, the analog module throws a diagnostic error. This will not occur in S7-PLCSIM. Any of the functionality that would have been performed by the physical module is not simulated in S7-PLCSIM.

PC-based controllers

S7-PLCSIM V15 does not support simulation of a PC-based controller.

Diagnostics

S7-PLCSIM does not support all of the error messages written to the diagnostic buffer. For example, S7-PLCSIM does not simulate messages about bad batteries in the CPU, or EPROM errors. However, S7-PLCSIM simulates most program errors.

Time-based performance

Because S7-PLCSIM is software running on a PC under the Windows operating system, the scan cycle time and the exact time of actions in S7-PLCSIM is not the same as if those actions were performed on physical hardware.

If your program is highly dependent on the time that actions execute, be aware that you should not evaluate your program based only on the time results of your S7-PLCSIM simulation.

Access and copy protection

S7-PLCSIM does not simulate access protection or copy protection.

Flashing LEDs

You can flash the LED lights on a PLC in the STEP 7 "Extended download to device" dialog box, but S7-PLCSIM does not simulate this functionality.

Features requiring the SD memory card

S7-PLCSIM does not simulate SD memory cards. Therefore, you cannot simulate CPU functionality that requires a memory card. For example, the data logging feature writes all output to the SD card, so the data logging feature cannot be simulated.
Data logging

S7-PLCSIM does not support data logging because this feature writes all output to the SD card, and S7-PLCSIM does not support the use of an SD card.

Recipes

S7-PLCSIM does not support recipes because recipe data is stored in an SD card and S7-PLCSIM does not support the use of the SD card.

Web server

S7-PLCSIM does not support Web server functionality.

PROFIBUS

If your STEP 7 project contains PROFIBUS elements, S7-PLCSIM will not simulate the PROFIBUS elements, but the remainder of your project simulates as usual.

You do not need to remove the PROFIBUS elements from your project before starting your simulation. Just be aware that S7-PLCSIM ignores the PROFIBUS elements.

2.7.8.3 Differences specific to S7-1200 PLCs

S7-1200 CPU and firmware version compatibility

S7-PLCSIM simulates only the following S7-1200 PLCs:

- S7-1200 PLCs with firmware version 4.0 or higher
- S7-1200F PLCs with firmware version 4.1 or higher

Adjusting STEP 7 program settings for S7-1200 Fail-Safe CPUs

In order to simulate an S7-1200F PLC, you must adjust the F-parameter F-monitoring time in your STEP 7 project before you perform a download to S7-PLCSIM. This is due to the difference in timing between a software-based simulation and actual physical hardware.

Procedure to adjust the F-monitoring time in STEP 7

To adjust the F-monitoring time, follow these steps:

1. In the STEP 7 Project tree, right-click your F-CPU and select "Properties".
2. In the Properties dialog, go to "Fail-Safe > F-parameter > Default F-monitoring time for central F-IO".
3. Adjust the F-monitoring time from the default of 150 ms to a higher value.
4. Click OK.

You might need to repeat this procedure until you find an F-monitoring value that allows your F-CPU simulation to run without errors.
Know-how protection and S7-1200 CPUs

S7-PLCSIM V15 cannot simulate projects with know-how protected blocks for S7-1200 CPUs.

You must remove know-how protection before starting a simulation with S7-PLCSIM.

Instruction support: S7-1200

S7-PLCSIM supports most instructions for the simulated S7-1200 and S7-1200F in the same way as for a physical PLC.

Some instructions are partially supported. For these instructions, S7-PLCSIM validates input parameters and returns outputs that are valid, but not necessarily what a real PLC with physical IO would return. For example, S7-PLCSIM does not support the SIMATIC memory card and program instructions that save data log data on a memory card do not actually save any data when executed.

You can download all programs that successfully compile to the virtual PLC. However, some instructions call SFCs (system functions) or SFBs (system function blocks) that are only partially supported, and your simulation might not function as you expect.

Technology module and technology object support: S7-1200

Technology module support

S7-PLCSIM does not simulate the following technology modules:

- Counting
- PID Control
- Motion Control

Technology object support

S7-PLCSIM does not currently support the following technology objects:

- Motion control
- PID

Supported communication instructions: S7-1200

S7-PLCSIM supports the following communication instructions for the S7-1200 and S7-1200F PLCs:

- PUT and GET
- TSEND and TRCV
- TSEND_C and TRCV_C
2.7.8.4 Differences specific to S7-1500 PLCs

S7-1500 CPUs and firmware version compatibility

S7-PLCSIM V15 supports all firmware versions of the S7-1500, S7-1500C, S7-1500T, and S7-1500F CPUs.

Adjusting STEP 7 program settings for S7-1500 Fail-Safe CPUs

In order to simulate an S7-1500F PLC, you must adjust the F-parameter F-monitoring time in your STEP 7 project before you perform a download to S7-PLCSIM. This is due to the difference in timing between a software-based simulation and actual physical hardware.

Procedure to adjust the F-monitoring time in STEP 7

To adjust the F-monitoring time, follow these steps:

1. In the STEP 7 Project tree, right-click your F-CPU and select "Properties".
2. In the Properties dialog, go to "Fail-Safe > F-parameter > Default F-monitoring time for central F-IO".
3. Adjust the F-monitoring time from the default of 150 ms to a higher value.
4. Click OK.

You might need to repeat this procedure until you find an F-monitoring value that allows your F-CPU simulation to run without errors.

S7-1500 programs with know-how protection

S7-PLCSIM V15 provides simulation support for S7-1500 projects containing know-how protected blocks. You must explicitly enable simulation support in STEP 7 for any S7-1500 project you intend to download to S7-PLCSIM V15.
Enabling simulation support

To enable simulation support:

1. Open the “Properties” for the project
2. Select the “Protection” tab
3. Select the checkbox next to “Support simulation during block compilation”
4. Recompile your project

Note
Before you compile your know-how protected blocks with simulation support enabled, you must remove the know-how protection for each block. Then recompile the project with simulation support enabled.

You can re-enable know-how protection after recompiling is complete.

Instruction support: S7-1500

S7-PLCSIM supports most instructions for the S7-1500, S7-1500C, and S7-1500F in the same way as a physical PLC.

Some instructions are partially supported. For these instructions, S7-PLCSIM validates input parameters and returns outputs that are valid, but not necessarily what a real PLC with physical IO would return. For example, S7-PLCSIM does not support the SIMATIC memory card and instructions that create data log data on a memory card cannot actually read or write to a memory card.

You can download all programs that successfully compile to the virtual PLC. However, some instructions call SFCs (system functions) or SFBs (system function blocks) that are partially supported.

Technology module and technology object support: S7-1500

Technology module support

S7-PLCSIM supports the following technology modules for the S7-1500 and S7-1500F:

- Counting and measurement
- PID Control
- Time-based IO
- Motion Control
Technology object support

S7-PLCSIM supports the following technology objects for the S7-1500 and S7-1500F:

- Motion Control
- PID
- Counting and measurement

Supported communication instructions: S7-1500

S7-PLCSIM supports the following communication instructions for S7-1500 CPUs:

- PUT and GET
- BSEND and BRCV
- USEND and URCV
- TSEND and TRCV
- TSEND_C and TRCV_C

2.7.8.5 Differences specific to ET 200SP PLCs

ET 200SP CPUs and firmware version compatibility

S7-PLCSIM V15 supports all firmware versions of the ET 200SP and ET 200SPF CPUs.

Adjusting STEP 7 program settings for ET 200SP Fail-Safe CPUs

In order to simulate an ET 200SPF PLC, you must adjust the F-parameter F-monitoring time in your STEP 7 project before you perform a download to S7-PLCSIM. This is required because of the difference in timing between a software-based simulation and actual physical hardware.

Procedure to adjust the F-monitoring time in STEP 7

To adjust the F-monitoring time, follow these steps:

1. In the STEP 7 Project tree, right-click your F-CPU and select "Properties".
2. In the Properties dialog, go to "Fail-Safe > F-parameter > Default F-monitoring time for central F-IO".
3. Change the F-monitoring time from the default of 150 ms to a higher value.
4. Click OK.

You might need to repeat this procedure until you find an F-monitoring value that allows your F-CPU simulation to run without errors.
ET 200SP programs with know-how protection

S7-PLCSIM V15 provides simulation support for ET 200SP projects containing know-how protected blocks. You must explicitly enable simulation support in STEP 7 for any project you intend to download to S7-PLCSIM V15.

Enabling simulation support

To enable simulation support:
1. Open the “Properties” for the project
2. Select the “Protection” tab
3. Select the checkbox next to "Support simulation during block compilation"
4. Recompile your project

Note

Before you compile your know-how protected blocks with simulation support enabled, you must remove the know-how protection for each block. Then recompile the project with simulation support enabled.

You can re-enable know-how protection after recompiling is complete.

Instruction support: ET 200SP

S7-PLCSIM supports most instructions for the ET 200SP and the ET 200SPF in the same way as a physical PLC.

Some instructions are partially supported. For these instructions, S7-PLCSIM validates input parameters and returns outputs that are valid, but not necessarily what a real PLC with physical IO would return. For example, S7-PLCSIM does not support the SIMATIC memory card and instructions that create data log data on a memory card cannot actually read or write to a memory card.

You can download all programs that successfully compile to the virtual PLC. However, some instructions call SFCs (system functions) or SFBs (system function blocks) that are partially supported.
Technology module and technology object support: ET 200SP

Technology module support

S7-PLCSIM supports the following technology modules for the ET 200SP and ET 200SPF:

- Counting and measurement
- PID Control
- Time-based IO
- Motion Control

Technology object support

S7-PLCSIM supports the following technology objects for the ET 200SP and ET 200SPF:

- Motion Control
- PID
- Counting and measurement

Supported communication instructions: ET 200SP

S7-PLCSIM supports the following communication instructions for the ET 200SP and ET 200SPF PLCs:

- PUT and GET
- BSEND and BRCV
- USEND and URCV
- TSEND and TRCV
- TSEND_C and TRCV_C
2.8 Using the help system

2.8.1 Overview of the help system

A comprehensive online help system describes the features and procedures you need to work more effectively with S7-PLCSIM. The S7-PLCSIM help system functions in the same way as the TIA Portal help system. It opens in a separate window from the main S7-PLCSIM application so that you can continue to work while you obtain the information you need.

You can launch the online help in the following ways:
- Select "Show help" under "Help" on the main menu
- Click the F1 key anywhere in the application

Online help available in electronic manual format

The online help is also available in electronic manual format from:
- the installation disk
- your hard drive after installation
- the Siemens Industry Online Support [https://support.industry.siemens.com/cs/?lc=en-US] website

This gives you several ways to access the help in the format that is most useful to you, and makes it easier to print.

Intended audience

The help documentation is intended for personnel with knowledge of, and experience using:
- Industrial automation and automation engineering
- PLC programming
- SIMATIC PLCs
- STEP 7
- TIA Portal
S7-PLCSIM Readme and online Readme files

The Readme file included with S7-PLCSIM V15 contains information that could not be included in the online help at the time the product was released. Information in the Readme file supersedes information in other documentation, and it is recommended that you read it carefully.

Additionally, the Readme file is updated as needed, and the updates are posted online. If you encounter unexpected behavior in S7-PLCSIM, consult the online version of the Readme file to see if there is a topic that addresses your issue. Visit the Siemens Industry Online Support [https://support.industry.siemens.com/cs/?lc=en-US] website and search for "S7-PLCSIM V15 Readme".

Note
Each S7-PLCSIM version has a separate online Readme file

There is a separate online Readme file for each release of S7-PLCSIM, so be sure you have located the online Readme for S7-PLCSIM V15 rather than for one of the earlier versions.

Online service and support

All of the SIMATIC product and system technical documentation is available on the Siemens Industry Online Support [https://support.industry.siemens.com/cs/?lc=en-US] website, where you can find the following information:

- News about the latest information on your products
- Documentation for your products
- Forums for worldwide knowledge exchange between users and experts
- Your local contact for Siemens Industry products and services
- Information about on-site services, repairs, spare parts, and much more
2.8.2 Searching the help system

The S7-PLCSIM V15 information system contains both the S7-PLCSIM help and the TIA Portal help. The two help systems appear under the "Content" tab. Under the "Content" tab:

- the S7-PLCSIM help is designated as "S7-PLCSIM online help"
- the TIA Portal help is designated as "Information System"

Search result display

When you search for information, results might show matching topics from both the S7-PLCSIM help and the TIA Portal help.

As an example, search on the term "display format" in the "Search for:" box on the left-hand side of the information system. The results of the search will contain both S7-PLCSIM and TIA Portal topics.

If you want to view only the S7-PLCSIM help search results, sort on the "Position" column header and the S7-PLCSIM help search results are grouped together. In this way you can be sure you are seeing all of the S7-PLCSIM search results. This makes it easier for you to determine which S7-PLCSIM help topic will address your display format question in the way that is most useful to you.

2.8.3 Readme and Online Readme files

The S7-PLCSIM V15 Readme and Online Readme files provide information on working with S7-PLCSIM V15 that was not known at the time the product was released for sale.

S7-PLCSIM Readme file

The Readme file is available at the time you install S7-PLCSIM V15.

You can access the Readme file during installation by clicking the "Read product information" button.

You can access the Readme file after installation by searching for the file in one of two ways:

- Navigate to the folder in which you installed S7-PLCSIM V15
- Search for the specific file on your hard drive by using the Windows Start menu search box

There is one Readme file for each language, as follows:

<table>
<thead>
<tr>
<th>Language</th>
<th>File name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chinese (simplified)</td>
<td>ReadMePE2MzhCN.chm</td>
</tr>
<tr>
<td>English</td>
<td>ReadMePE2MenUS.chm</td>
</tr>
<tr>
<td>French</td>
<td>ReadMePE2MtFR.chm</td>
</tr>
<tr>
<td>German</td>
<td>ReadMePE2MdeDE.chm</td>
</tr>
<tr>
<td>Italian</td>
<td>ReadMePE2MitIT.chm</td>
</tr>
<tr>
<td>Spanish (modern)</td>
<td>ReadMePE2MesES.chm</td>
</tr>
</tbody>
</table>
S7-PLCSIM Online Readme file

The Readme file is updated as needed, and the updates are posted online as Online Readme files.

If you encounter unexpected behavior in S7-PLCSIM, consult the online version of the Readme file to see if there is a topic that addresses your issue. Visit the Siemens Industry Online Support website [https://support.industry.siemens.com/cs/?lc=en-US] and search for "S7-PLCSIM V15 Readme".

There is an Online Readme file for each language.

Note
Each S7-PLCSIM version has a separate Online Readme file

There is a separate Online Readme file for each release of S7-PLCSIM, so be sure you have located the Online Readme for S7-PLCSIM V15 rather than for one of the earlier versions.
3

Startup options

3.1 Overview of startup options

You can start in either Compact view or Project view by selecting your preferred method under "Options > Settings" on the main toolbar.

There are several options you can use to start working with S7-PLCSIM:

- Startup from the TIA Portal
- Startup from the Windows desktop icon or start menu
- Startup from an existing S7-PLCSIM project

3.2 Startup from TIA Portal

3.2.1 Overview of startup from the TIA Portal

You must explicitly enable simulation support in TIA Portal V15 before you start a simulation with S7-PLCSIM V15 for S7-1500 and ET 200SP CPUs.

Know-how protection also affects the steps you must take in order to start a simulation.

3.2.2 Enabling simulation support

Starting with TIA Portal V15, you must explicitly enable simulation support for any program you intend to download to S7-PLCSIM V15.

To enable simulation support in STEP 7:

- navigate to the project properties
- select the Protection tab
- select the checkbox to support simulation of know-how protected blocks
- re-compile the project
3.2.3 Know-how protection and startup

Know-how protection and startup depend on the CPU family you are simulating.

S7-1200 CPUs

You cannot download an S7-1200 program containing know-how protected blocks to S7-PLCSIM. Remove know-how protection before you attempt to start a simulation.

S7-1500 and ET 200SP CPUs

You must compile know-how protected blocks for S7-1500 and ET 200SP CPUs with simulation support enabled. You must remove the know-how protection from the blocks before they can be compiled with simulation support. Remove know-how protection (using the appropriate password) for each block, then re-compile the project.

3.2.4 The Start simulation command

In STEP 7, the "Start simulation" command is available for devices that S7-PLCSIM is able to simulate. When S7-PLCSIM V15 is installed, the simulation options are enabled for the supported PLC families (S7-1200, S7-1500, and ET 200SP).

Select "Start simulation" to launch a new instance of S7-PLCSIM. By default, S7-PLCSIM launches in Compact view with no open project.

If you want to use an already-running instance of S7-PLCSIM, select the "Download" command.

You can start a simulation in one of two ways:

- Click the "Start simulation" button on the main toolbar.
- Right-click the device in the Project tree and select "Start simulation" from the shortcut menu.
3.3 Startup from desktop icon or start menu

3.3.1 Overview of starting from a desktop icon or start menu
You can start S7-PLCSIM from the desktop icon or from the Windows start menu. When you start from the desktop icon or start menu, S7-PLCSIM launches without an open project.

3.4 Startup from an existing S7-PLCSIM project

3.4.1 Overview of startup from an existing project
You can use previously saved S7-PLCSIM projects for simulation. The S7-PLCSIM project contains the SIM tables and sequences that you previously created and saved. Your project also contains the hardware and software configuration you downloaded to the simulation. The configuration is automatically restored to the simulation when you open the S7-PLCSIM project.

There are two ways you can open an existing S7-PLCSIM project:
- open by double-clicking the file in Windows Explorer
- open from the S7-PLCSIM main menu or main toolbar in Project view

3.4.2 Open a project by double-clicking the file name
You can open an existing project by double-clicking a *.sim15 project in file explorer. In this case, S7-PLCSIM will always launch in Project view, regardless of the application setting for "Start view". The following will occur:
- The Project view opens and displays the SIM tables and sequences for the project.
- If the project has a saved simulation, the correct family of virtual PLC is launched.
- If the virtual PLC was previously configured by a download, it goes online with the running simulation, and displays the hardware configuration in Device configuration.
3.4.3 Open a project from main menu or main toolbar

You can open a project in Project view by:

- navigating to Main menu > Project > Open project
- clicking the "Open project" button on the main toolbar

**Note**

You cannot open a project while you are in Compact view. You must switch to Project view to open a project.

3.4.4 Opening an S7-PLCSIM V14 SP1 project

A project created and saved with S7-PLCSIM V14 SP1 can be directly opened in S7-PLCSIM V15. When you select the project, a message box displays to notify you that the project must be converted to an S7-PLCSIM V15 (*.sim14 to *sim15). Part of the upgrade process is to make a new project folder for the upgraded project. Once the upgrade is complete, the project opens normally. This newly-converted project will then be saved in a format that is no longer compatible with S7-PLCSIM V14 SP1.

3.4.5 Opening a project created prior to V14 SP1

It is not possible to directly open S7-PLCSIM projects created and saved with a version older than S7-PLCSIM V14 SP1. To open these projects with S7-PLCSIM V15, follow this procedure:

1. Open the project with S7-PLCSIM V14 SP1.
2. Save the project as an S7-PLCSIM V14 SP1 project.
3. Open the project with S7-PLCSIM V15.

3.4.6 Using an existing S7-PLCSIM project for simulation and debugging

Once you have opened the S7-PLCSIM project, the simulation is active and ready for debugging in either S7-PLCSIM or STEP 7.

If you open a project that was previously used to create the simulation, you can simply open this project and "go online" with the correct CPU, using the same procedure that you would use to go online with a real PLC.

If you do not have the STEP 7 project that was previously used to create the simulation, it is still possible to use STEP 7 for debugging. You can open a new STEP 7 project and select to upload from the running simulation. When you do this, the hardware configuration and program are created in the STEP 7 project, and you can go online with the running simulation. Again, this is the same behavior as if you were connected with a real PLC.
4.1 Overview of modifying a running simulation

After a simulation begins running, you are still able to download any changes you make in the TIA Portal to your program or configured hardware.

S7-PLCSIM accepts any changes to your hardware configuration without error as long as you do not change the CPU family of the hardware. The following example scenarios illustrate a successful download and an unsuccessful re-configuration of the simulation.

Example scenario: change to a CPU within the same CPU family

1. You first download the hardware and software of a project configured for a CPU 1211 V4.0 (6ES7 211-1AE40-0XB0).
2. You then change the hardware configuration to be a CPU 1217 V4.2 (6ES7 217-1AG40-0XB0).
3. Then you download the hardware configuration.

This simulation scenario would not be allowed for a "real" PLC. The V4.0 device would not accept the download of a V4.2 configuration because the TIA Portal would block the download. However, this is allowed for a simulation. The download dialog will indicate that the download is to a simulation. The download will succeed, and you can view the result in Device configuration view.

Example scenario: change to a CPU within a different CPU family

It is not possible to change the CPU family for a running simulation. Consider the following example scenario:

1. You first download the hardware and software of a project configured for a CPU 1211 V4.0 (6ES7 211-1AE40-0XB0).
2. You then change the hardware configuration to be a CPU 1511 V2.0 (6ES7 511-1AK01-0AB0).
3. You then attempt to download the hardware configuration.

This scenario is blocked because the TIA Portal will not find a suitable download target.
4.2 Simulating a power cycle

The screen capture below shows the compact view with a running, configured S7-1200 CPU simulation.

Notice the following:

- The power button is green
- The configured CPU name is displayed
- The communications (IP) address is shown
- The LEDs are active
- The RUN, STOP, and MRES buttons are enabled

Clicking the power button to turn off the simulation results in the following:
Modifying a running simulation

4.3 Changing the CPU family being simulated

Note what has, and has not, changed in the user interface:

- The power button is gray
- The configured CPU name is still displayed
- The communications (IP) address is removed
- The LEDs are disabled
- The RUN, STOP, and MRES are disabled
- The CPU family selection is visible

The virtual PLC configuration is retained when you stop the simulation. If you click the power button again, the new simulation starts with the same configuration. This has the effect of "power cycling" the previous simulation.

4.3 Changing the CPU family being simulated

Another purpose of modifying a running simulation is to change the CPU family being simulated. Here, the simulation is in Compact view in the powered off state:

The drop-down list for the CPU family is visible. Clicking the down arrow displays the list of supported CPU families:
If you change CPU families and then click the power button, this will start a new, unconfigured simulation of the family you selected. The configuration from the previous simulation is discarded. The Compact view now appears as follows:

- The Unconfigured CPU name is displayed
- No communications address is shown
- The LEDs and the RUN, STOP, and MRES buttons are disabled

Appearance in Project view

Project view shows an open S7-PLCSIM project if you have created or changed a project. Changing the simulation family and starting a new simulation causes the Project tree to update to show the new, unconfigured simulation.
4.4 Configured versus unconfigured simulations

When a new simulation is started, the simulation is said to be "unconfigured". An unconfigured simulation can accept connection requests at any network address. At startup, an unconfigured simulation has a default address for each supported communications protocol.

Example scenario:

Under this scenario, assume you have an S7-PLCSIM v5.4.8 simulation with the following default address information:

MPI=2 DP=2 Local=2 IP=192.168.0.1 ISO=08-00-12-34-56-78

The virtual PLCs supported by S7-PLCSIM V15 only support IP communications. Assume you have a simulation at the default communications address at:

IP=192.168.0.1

When STEP 7 requests to connect with a simulation at a specific address, S7-PLCSIM first checks whether there is a configured simulation at that address. If yes, then STEP 7 connects to that simulation.

If there is no existing simulation configured for that address, STEP 7 connects to the first unconfigured simulation. In this case, it may connect to the v5.4.8 simulation.

When an unconfigured simulation receives a hardware download, S7-PLCSIM recognizes that the simulation has become configured. Connections must then be to the simulation except for the specific, configured address.
Working in Compact view

5.1 Overview of working in Compact view

Compact view is the default view for S7-PLCSIM. It has a small computer screen "footprint", and can function as a virtual PLC while you debug your program using STEP 7.

If you prefer to launch in Project view, you can change the default view from the Project view main menu under Options > Settings.

You cannot perform project actions or run sequences in Compact view. You must switch to Project view in order to use these functions.

The functionality of Compact view is detailed in the following sections.

5.2 Compact view user interface

When you launch S7-PLCSIM V15 in Compact view from your computer desktop, Compact view opens with no project and no simulation.

The following screenshot shows Compact view in this state:

![Compact view screenshot](image-url)
5.2 Compact view user interface

Description of the Compact view user interface

Compact view has four main sections:

- Title bar
- CPU name
- CPU control panel
- Project name

① Title bar

Displays the S7-PLCSIM logo and three control buttons:

- "Keep on top" button - Causes Compact view to display on top of all other windows.
- "Minimize" button - Standard Windows functionality.
- "Close button" - Standard Windows functionality.

② CPU name

This section of Compact view shows the name and type of the virtual PLC. Different text is displayed based on the state of the application:

- No open simulation - displays "<no simulation>"
- Unconfigured simulation (no download has been performed) - displays "Unconfigured"
- "Configured simulation (a download has been performed)" - displays the name you assigned the CPU, along with the CPU type (for example, "MyPLC [CPU 1215 DC/DC/DC"]

The CPU name section also contains the "Switch to project view" button.
5.3 Using memory reset (MRES) in Compact view

A memory reset clears all working memory areas and copies load memory to working memory. You can perform a memory reset by using the MRES button in Compact view.

Memory reset procedure

Initial state: you are running an active simulation.
- If you are in Project view, switch to Compact view.
- Click the MRES button.
- The virtual PLC power cycles.
- The connection between STEP 7 and S7-PLCSIM is broken.
- S7-PLCSIM goes back online automatically.
- STEP 7 does not automatically go online.

Result: M memory and Data Block values return to their start values.
5.3 Using memory reset (MRES) in Compact view
Working in Project view

6.1 Project view user interface

6.1.1 Project view user interface overview

Project view provides the full functionality of S7-PLCSIM. The screenshot below shows the main components of the Project view with two editors visible in a horizontally split window:
Working in Project view

6.1 Project view user interface

1. Title bar  Displays the project path and project name, and buttons to switch to Compact view, minimize the application, maximize the application, and close S7-PLCSIM.

2. Menu bar  Displays menus for project commands, edit commands, execute commands, options settings, tool commands, window commands, and help commands.

3. Toolbar  Displays buttons for project commands, edit commands, execute commands, switching to Compact view, window commands, and recording tool commands.

4. Project tree  Displays the project name, the simulated PLC type, and navigation to Device configuration, SIM tables, and sequences.

5. Editor windows  Displays editors for Device configuration, SIM tables, and sequences. You can display two editors at the same time either horizontally or vertically.

6. Editor bar / status bar with progress display  Displays shortcuts to open editors and the status of the simulated PLC.

Switching to Compact view from Project view

You can switch from Project view to Compact view by clicking the "Switch to Compact view" button on the main toolbar.

6.1.2 The S7-PLCSIM menu bar

6.1.2.1 S7-PLCSIM menu bar

The following image shows the user interface for the S7-PLCSIM main menu, along with a description of each section of the menu:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Contains commands for creating new projects; opening existing projects; closing, deleting, and saving projects; and exiting S7-PLCSIM. There is also a list of your most recent projects.</td>
</tr>
<tr>
<td>Edit</td>
<td>Contains commands to open, cut, copy, paste, delete, and rename an object in the simulation project. You can also view the properties of the simulation project, including the project name, creation time, time of the last change to the project, and the project storage path. You can also enter an author name and comments for the project.</td>
</tr>
<tr>
<td>Execute</td>
<td>Switches the simulated PLC to RUN mode or to STOP mode.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the settings dialog so you can adjust the application settings.</td>
</tr>
<tr>
<td>Window</td>
<td>Allows you to customize the workspace.</td>
</tr>
<tr>
<td>Help</td>
<td>Opens the help system, provides a link to the Siemens Industry Online Support website, and shows details of the installed software.</td>
</tr>
</tbody>
</table>
6.1.2.2 S7-PLCSIM menu bar commands

S7-PLCSIM project menu commands

The Project commands are as follows:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New</strong></td>
<td>Creates a new project and a new simulated PLC. If the current project contains unsaved changes, you are asked to save the project. S7-PLCSIM automatically assigns a name and file extension of “Project(n).sim15” to the new project, where (n) is the next numbered project created. You can change the project name in the Project properties if you want to do so.</td>
</tr>
<tr>
<td><strong>Open</strong></td>
<td>Allows you to select an existing project to open.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Closes the current simulation project. If the current project contains unsaved changes, you are asked to save the project.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Saves the simulation project using the current path and file name. “Save” is disabled during a download from STEP 7.</td>
</tr>
<tr>
<td><strong>Save as...</strong></td>
<td>Allows you to save your project with a new name and/or a new path. “Save as...” is disabled during a download from STEP 7.</td>
</tr>
<tr>
<td><strong>Delete project</strong></td>
<td>Allows you to select a project for deletion.</td>
</tr>
<tr>
<td><strong>&lt;List of recent projects&gt;</strong></td>
<td>The application keeps a list of your most recently saved simulation projects. You can open one of the projects by clicking it. If your current project contains unsaved changes, you are asked to save the project before opening your selected project.</td>
</tr>
<tr>
<td><strong>Exit</strong></td>
<td>Closes the simulated PLC and the S7-PLCSIM application. If the current project contains unsaved changes, you are asked to save the project.</td>
</tr>
</tbody>
</table>
### S7-PLCSIM edit menu commands

The Edit functions are as follows:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
</table>
| Open object | This menu item is enabled when an object that can be opened has application focus. This is true when the focus is on the Project tree and one of the following elements is selected:  
  - the simulated PLC  
  - a SIM table  
  - a sequence |
| Cut | Standard clipboard Cut functionality. Cut is enabled or disabled based on your current selection. |
| Copy | Standard clipboard Copy functionality. Copy is enabled or disabled based on your current selection. |
| Paste | Standard clipboard Paste functionality. Paste is enabled or disabled based on your current selection. |
| Delete | Standard Delete functionality. Delete is enabled or disabled based on your current selection. |
| Rename | Allows you to rename the selected object. Rename is enabled when you select one of the following Project tree elements:  
  - A SIM table  
  - A sequence |
| Properties | Displays the properties of the project, including the project name, creation time, time of the last change to the project, and the project storage path. You can also enter an author name and comments for the project. |
S7-PLCSIM execute menu commands

The Execute functions are as follows:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start CPU</td>
<td>Transitions the simulated PLC to RUN mode. The Start CPU button is only enabled when the simulated PLC is in STOP mode.</td>
</tr>
<tr>
<td>Stop CPU</td>
<td>Transitions the simulated PLC to STOP mode. The Stop CPU button is only enabled when the simulated PLC is in RUN mode.</td>
</tr>
</tbody>
</table>

S7-PLCSIM options menu commands

The Options section contains only one command:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Allows you to make changes to the appearance and behavior of the workspace.</td>
</tr>
</tbody>
</table>

Application settings

Application settings allow you to customize the behavior of S7-PLCSIM. For example, you can choose whether or not to display automatically cascading tooltips, or whether to change the default storage location for projects.

A complete list of configurable settings is as follows:
## General settings

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application settings</td>
<td>User name</td>
<td>When you create a new project, this is the user name that is saved automatically in the project properties. The default is the Windows user name. You can change the name here if you want to do so.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>User interface language</td>
<td></td>
<td>You can change the user interface language here. The default is English.</td>
</tr>
<tr>
<td>Mnemonic</td>
<td></td>
<td>You can specify the mnemonic for programming:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;German&quot; uses the German mnemonics; for example, &quot;E1.0&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• &quot;International&quot; uses the international mnemonics; for example, &quot;I1.0&quot;</td>
</tr>
<tr>
<td>Show list of recently used projects</td>
<td></td>
<td>Use this to change the number of recently used projects listed under &quot;Main Menu &gt; Project&quot;. The default is eight.</td>
</tr>
<tr>
<td>Open cascade automatically in tooltips</td>
<td></td>
<td>This check box allows you to display or not display expanded (cascading) information for a tooltip. The box is checked as the default. If you clear the check box, you can still use the help system to obtain further information.</td>
</tr>
<tr>
<td>Start view</td>
<td>Project view</td>
<td>Select this option if you want to always start S7-PLCSIM in Project view.</td>
</tr>
<tr>
<td></td>
<td>Compact view</td>
<td>This option is selected by default. S7-PLCSIM starts in Compact view.</td>
</tr>
<tr>
<td>Reset to default</td>
<td>All application settings</td>
<td>Click &quot;Reset to default&quot; to return to original application settings.</td>
</tr>
<tr>
<td></td>
<td>Editor layouts</td>
<td>Click &quot;Reset to default&quot; to return only the SIM table and Sequence editors to their original application settings.</td>
</tr>
<tr>
<td>Storage settings</td>
<td>Recently used storage location</td>
<td>You can select either this option or the &quot;Default storage location&quot; option. If you select the &quot;Recently used storage location&quot; button, any open project will be saved in the location that your last project was saved.</td>
</tr>
<tr>
<td></td>
<td>Default storage location</td>
<td>You can select either this option or the &quot;Default storage location&quot; option. If you select &quot;Default storage location&quot;, your project will be saved at the path listed under &quot;Storage location for projects&quot;.</td>
</tr>
<tr>
<td></td>
<td>Storage location for projects</td>
<td>Enabled when you select &quot;Default storage location&quot;. You can change the storage location by entering the path or browsing to the folder you want to use.</td>
</tr>
</tbody>
</table>
### Working in Project view

6.1 Project view user interface

<table>
<thead>
<tr>
<th>Item</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cycle time monitoring</td>
<td>Use downloaded maximum cycle time</td>
<td>Select this option to use the maximum cycle time in the project downloaded from STEP 7.</td>
</tr>
<tr>
<td>(Note that changes to cycle time settings are immediately reflected in the simulated PLC)</td>
<td>Disable scan cycle monitoring</td>
<td>Select this option to prevent a possible cyclic event overflow error from occurring.</td>
</tr>
<tr>
<td></td>
<td>Specify maximum cycle time</td>
<td>To change the maximum cycle time, select this option and then input the new time in the &quot;Maximum cycle time&quot; box.</td>
</tr>
<tr>
<td></td>
<td>Maximum cycle time</td>
<td>If you selected &quot;Specify maximum cycle time&quot;, input your new maximum cycle time in this box. The acceptable range is 150 ms to 60000 ms (1 minute).</td>
</tr>
</tbody>
</table>

### S7-PLCSIM tools menu commands

The Tools commands are as follows:

- **Start recording**: Starts recording actions in the SIM table editor or the Addresses section of Device configuration.
- **Stop recording**: Stops recording actions in the SIM table editor or the Addresses section of Device configuration and then creates a new sequence from the recording in the Project tree.
- **Pause recording**: Pauses a recording.
S7-PLCSIM window menu commands

The Window functions allow you to customize the workspace to fit your needs and to switch the application to Compact view.

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close all</td>
<td>Closes all open editor windows.</td>
</tr>
<tr>
<td>Minimize all</td>
<td>Minimizes all open editor windows. The editors are still active and are available by using the icons in the editor frame.</td>
</tr>
<tr>
<td>Compact view</td>
<td>Transitions the application to Compact view. The main S7-PLCSIM view becomes invisible.</td>
</tr>
<tr>
<td>Next editor</td>
<td>Used to switch between open editor windows. The ordering of the open editors is the order in which they were opened. &quot;Next editor&quot; is disabled if only one editor is open.</td>
</tr>
<tr>
<td>Previous editor</td>
<td>Used to switch between open editor windows. The ordering of the open editors is the order in which they were opened. &quot;Previous editor&quot; is disabled if only one editor is open.</td>
</tr>
<tr>
<td>Split editor space vertically</td>
<td>Creates a vertically split work space so that you can view two editor windows concurrently.</td>
</tr>
<tr>
<td>Split editor space horizontally</td>
<td>Creates a horizontally split work space so that you can view two editor windows concurrently.</td>
</tr>
<tr>
<td>Unsplit editor space</td>
<td>Returns a vertically or horizontally split work space to a single editor window.</td>
</tr>
</tbody>
</table>
S7-PLCSIM help menu commands

The Help functions are as follows:

<table>
<thead>
<tr>
<th>Menu text</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show help</td>
<td>Opens the help system.</td>
</tr>
<tr>
<td>Service &amp; Support in Internet</td>
<td>Provides a link to the Siemens Industry Online Support website.</td>
</tr>
<tr>
<td>Installed software</td>
<td>Displays information about your installed Siemens software, including</td>
</tr>
<tr>
<td></td>
<td>version numbers for S7-PLCSIM and the TIA Portal.</td>
</tr>
</tbody>
</table>

6.1.3 The S7-PLCSIM toolbar

6.1.3.1 S7-PLCSIM toolbar

The S7-PLCSIM toolbar provides the same functionality as the main menu, and also provides power on/power off and CPU family selection functionality:

The commands represented by these icons, from left to right on the toolbar, are as follows:

<table>
<thead>
<tr>
<th>Function</th>
<th>Short description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project command buttons</td>
<td>• Create a new project&lt;br&gt;• Open an existing project&lt;br&gt;• Save a project</td>
</tr>
<tr>
<td>Edit command buttons</td>
<td>• Cut&lt;br&gt;• Copy&lt;br&gt;• Paste&lt;br&gt;• Delete</td>
</tr>
<tr>
<td>Power buttons and CPU family selector</td>
<td>• Power the CPU on or off&lt;br&gt;• Select or change CPU family</td>
</tr>
<tr>
<td>Execute command buttons</td>
<td>• Place the CPU in RUN mode&lt;br&gt;• Place the CPU in STOP mode</td>
</tr>
<tr>
<td>Undo and redo command buttons</td>
<td>• Undo the last action&lt;br&gt;• Redo the last undo action</td>
</tr>
</tbody>
</table>
### 6.1 Project view user interface

#### 6.1.3.2 S7-PLCSIM toolbar objects

**S7-PLCSIM toolbar project buttons**

The Project actions on the main toolbar are as follows:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New project</td>
<td>Creates a new project. If your current project contains unsaved changes, you are asked to save the project. S7-PLCSIM automatically assigns a name and file extension of &quot;Project(n).sim15&quot; to the new project, where (n) is the next numbered project created. The project name can be changed if you want to do so.</td>
</tr>
<tr>
<td>Open project</td>
<td>Allows you to navigate to the project you want to open. If your current project contains unsaved changes, you are asked to save the project.</td>
</tr>
<tr>
<td>Save project</td>
<td>Saves the simulation project file using the current path and file name. You cannot save a project during a download from STEP 7.</td>
</tr>
</tbody>
</table>

**S7-PLCSIM toolbar editing buttons**

The Edit functions on the main toolbar are as follows:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Standard Windows clipboard Cut functionality for a selected object.</td>
</tr>
<tr>
<td>Copy</td>
<td>Standard Windows clipboard Copy functionality for a selected object.</td>
</tr>
<tr>
<td>Paste</td>
<td>Standard Windows clipboard Paste functionality for a selected object.</td>
</tr>
<tr>
<td>Delete</td>
<td>Standard Windows Delete functionality for a selected object.</td>
</tr>
</tbody>
</table>
S7-PLCSIM toolbar power buttons and CPU family selector

The power on/power off button and CPU family selector on the main toolbar are as follows:

From left to right, these objects perform the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power on/power off button</td>
<td>Powers the CPU on and off. The button is green when the power is on and gray when the power is off.</td>
</tr>
<tr>
<td>CPU family selector</td>
<td>Allows you to select the CPU family of the PLC you want to simulate.</td>
</tr>
</tbody>
</table>

S7-PLCSIM toolbar CPU execution buttons

The Execute functions available on the main toolbar are as follows:

From left to right, these icons perform the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RUN</td>
<td>Transitions the simulated PLC to RUN mode when there is an active simulation project.</td>
</tr>
<tr>
<td>STOP</td>
<td>Transitions the simulated PLC to STOP mode when there is an active simulation project.</td>
</tr>
</tbody>
</table>

S7-PLCSIM toolbar Window buttons

The actions available in the Window section of the main toolbar are as follows:

From left to right, these icons perform the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Split editor space horizontally</td>
<td>Allows you to view two editor windows concurrently by splitting the work-space horizontally.</td>
</tr>
<tr>
<td>Split editor space vertically</td>
<td>Allows you to view two editor windows concurrently by splitting the work-space vertically.</td>
</tr>
<tr>
<td>Compact view</td>
<td>Switches from Project view to Compact view.</td>
</tr>
</tbody>
</table>
S7-PLCSIM toolbar record/playback buttons

The toolbar buttons Record, Stop, and Pause enable you to record and save a series of actions in the SIM table editor or in the Addresses section of Device configuration and then play them back by using a sequence.

From left to right, these icons perform the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start recording</td>
<td>Starts recording actions in a SIM table or in the Addresses section of Device configuration.</td>
</tr>
<tr>
<td>Stop recording</td>
<td>Stops recording actions in the SIM table editor or the Addresses section of Device configuration and then creates a new sequence from the recording in the Project tree.</td>
</tr>
<tr>
<td>Pause recording</td>
<td>Pauses a recording.</td>
</tr>
</tbody>
</table>

S7-PLCSIM toolbar undo and redo buttons

The toolbar buttons Undo and Redo enable you to undo and redo certain actions.

From left to right, these buttons perform the following functions:

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Enables you to undo certain actions.</td>
</tr>
<tr>
<td>Redo</td>
<td>Enables you to redo actions you have previously undone.</td>
</tr>
</tbody>
</table>
6.1.4 Project tree description

The S7-PLCSIM project tree is similar in design and operation to the project tree in STEP 7. The top level folder in the tree represents the project. The project contains the downloaded PLC, the Device configuration, the SIM table(s), and the sequence(s).

The nodes in the project tree include the following:

**Project[n]**

- **Project folder**: Displays the current name of the simulation project. The default project name is "Project[n]", where [n] is the next incremental number available for name assignment. For example, the default name of your first S7-PLCSIM project is "Project1". The project folder contains the device (downloaded PLC).

**PLC_n [SIM-"CPU"]**

- **PLC folder**: This displays the name of the simulated PLC as configured in STEP 7, as well as the specific PLC.

  "Unconfigured PLC" displays until you perform a download from STEP 7. After a download, the name of the specific PLC you selected displays (for example, "PLC_1 [CPU 1516-3 PN/DP]").

- **Device configuration**: This node displays the Device configuration as downloaded from STEP 7.
SIM tables folder

A project can contain multiple SIM tables. This folder groups the project's SIM tables.

- **Add new SIM table**: Click this node to add a SIM table to your project. S7-PLCSIM creates a new SIM table with a unique default name and displays the new, empty SIM table in the SIM table editor. You can change the table name by right-clicking it and selecting "Rename".

- **SIM table_1**: By default, a new project contains a single SIM table with the default name "SIM table_1" so that you can immediately begin to enter and monitor addresses. You can change a SIM table name by right-clicking it and selecting "Rename".

Sequences folder

This folder contains the project's sequences. A project can contain multiple sequences.

- **Add new sequence**: Click this node to add a sequence to your project. S7-PLCSIM automatically assigns the new sequence a unique default name and displays the new, empty sequence in the sequence editor. You can change the sequence name by right-clicking it and selecting "Rename".

- **Sequence_1**: By default, a new project will contain a single sequence with the name "Sequence_1". You can rename a sequence by right-clicking its name and selecting "Rename".

6.1.5 Application settings

6.1.5.1 Overview of settings

You can set your preferences for working in S7-PLCSIM by selecting Options > Settings from the main menu in Project view. These settings allow you to customize S7-PLCSIM according to your environment and program.

The settings editor includes:

- application settings
- start view
- reset to default
- storage settings
- cycle time settings
6.1.5.2  **Application settings**

The Application settings enable you to change the default user name, the user interface language, the mnemonic, select the number of projects you have recently worked with, whether or not you would like tooltip cascades to open automatically, and whether to confirm that you want to exit S7-PLCSIM when you are in Compact view with a configured CPU.

6.1.5.3  **Start view**

Here you can select how you want S7-PLCSIM to launch. You can launch S7-PLCSIM in either Compact view or Project view.

Compact view is the default setting at installation.

6.1.5.4  **Reset to default**

These options allow you to reset your application settings. These buttons are identical to the buttons provided in the TIA Portal.
6.1.5.5 Storage settings

You can select the storage path for new projects here. These selections are the same as in the TIA Portal. The default setting is "Recently used storage location".

6.1.5.6 Cycle time settings

S7-PLCSIM provides cycle time options so you can adjust the timing to your specific PC. If you have a slower or older PC, you might want to disable cycle time monitoring, or adjust the maximum cycle time.

Your cycle time setting is communicated to the simulated PLC when you start up S7-PLCSIM. The simulated PLC uses this value throughout simulation operations.

The acceptable cycle time range is 150 ms to 60000 ms (0.15 seconds to 1 minute).

The default setting for cycle time monitoring is “Disable scan cycle monitoring”. The default setting for the maximum cycle time is 150 ms.

6.1.5.7 Undo/redo in application settings

The application settings editor does not support undo/redo.
6.1.6 Managing the workspace

You can customize the S7-PLCSIM workspace to conform to your preferred work style just as you can with many other Windows applications:

- You can drag the right bar of the Project tree to show more information.
- You can collapse the Project tree by choosing "Collapse" or "Collapse automatically".
- You can resize columns in SIM tables and sequences.
- You can open and close parts of the application by either clicking them in the Project tree or by opening and closing them in the status bar.
- You can split the workspace vertically or horizontally to show two work areas at the same time.
- You can float windows.

You can further customize your workspace by selecting "Options > Settings" from the main menu.

If you split the screen vertically or horizontally, each pane contains either a "pin" icon or an "unpin" icon. Click the "pin" icon to keep one of the panes constant as you view objects in the other pane. For example, if you have several sequences, you can pin one of them to keep it visible while you cycle through other sequences in the unpinned pane. Clicking Ctrl+F6 in an unpinned pane allows you to cycle between sequences (or any other work area you want to view).

If you reposition or resize your editor windows, you can save the new layout by clicking the "Save window settings" button in the upper right corner of each editor.
### 6.1.7 Keyboard shortcuts

The following table lists the Windows keyboard shortcuts that you can use in S7-PLCSIM:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>TIA Portal / S7-PLCSIM</th>
<th>MS Windows</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALT</td>
<td>X</td>
<td></td>
<td>Activate or inactivate menu bar mode</td>
</tr>
<tr>
<td>ALT+0-9</td>
<td>X</td>
<td></td>
<td>Reserved to enter ASCII code via number pad</td>
</tr>
<tr>
<td>ALT+A-Z</td>
<td>X</td>
<td></td>
<td>Reserved for opening menus</td>
</tr>
<tr>
<td>ALT+CTRL+LEFT</td>
<td>X</td>
<td></td>
<td>Previous open editor</td>
</tr>
<tr>
<td>ALT+CTRL+RIGHT</td>
<td>X</td>
<td></td>
<td>Next open editor</td>
</tr>
<tr>
<td>ALT+ESC</td>
<td>X</td>
<td></td>
<td>Activate the next application</td>
</tr>
<tr>
<td>ALT+F4</td>
<td>X</td>
<td></td>
<td>Close the application</td>
</tr>
<tr>
<td>ALT+F7</td>
<td>X</td>
<td></td>
<td>Toggle between Compact view and Project view</td>
</tr>
<tr>
<td>ALT+PRINT SCREEN</td>
<td>X</td>
<td></td>
<td>Copies an image of the active window onto clipboard</td>
</tr>
<tr>
<td>ALT+SHIFT+A-Z</td>
<td>X</td>
<td></td>
<td>Reserved for opening menu</td>
</tr>
<tr>
<td>ALT+SHIFT+ESC</td>
<td>X</td>
<td></td>
<td>Activate the previous application</td>
</tr>
<tr>
<td>ALT+SHIFT+TAB</td>
<td>X</td>
<td></td>
<td>Switches to the previous application. The user must press and hold down ALT+SHIFT while pressing TAB</td>
</tr>
<tr>
<td>ALT+SPACE BAR</td>
<td>X</td>
<td></td>
<td>Opens the window menu for the application's main window</td>
</tr>
<tr>
<td>ALT+TAB</td>
<td>X</td>
<td></td>
<td>Switches to the next application</td>
</tr>
<tr>
<td>APPLICATION KEY</td>
<td>X</td>
<td></td>
<td>Opens context menu</td>
</tr>
<tr>
<td>CTRL+0</td>
<td>X</td>
<td></td>
<td>Zoom 100%</td>
</tr>
<tr>
<td>CTRL+1</td>
<td>X</td>
<td></td>
<td>Opens/ closes the PNV</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>X</td>
<td></td>
<td>Select all</td>
</tr>
<tr>
<td>CTRL+ALT+DELETE</td>
<td>X</td>
<td></td>
<td>Activate Windows security dialog</td>
</tr>
<tr>
<td>CTRL+ALT+TAB</td>
<td>X</td>
<td></td>
<td>Switches to aero style on Vista</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>X</td>
<td></td>
<td>Copy</td>
</tr>
<tr>
<td>CTRL+DOWN</td>
<td>X</td>
<td></td>
<td>Jump down</td>
</tr>
<tr>
<td>CTRL+END</td>
<td>X</td>
<td></td>
<td>Go to the very end</td>
</tr>
<tr>
<td>CTRL+ESC</td>
<td>X</td>
<td></td>
<td>Activates the Start menu</td>
</tr>
<tr>
<td>CTRL+F12</td>
<td>X</td>
<td></td>
<td>Split the editor horizontally</td>
</tr>
<tr>
<td>CTRL+F4</td>
<td>X</td>
<td></td>
<td>Closes the active editor</td>
</tr>
<tr>
<td>CTRL+F6</td>
<td>X</td>
<td></td>
<td>Next open editor</td>
</tr>
<tr>
<td>CTRL+HOME</td>
<td>X</td>
<td></td>
<td>Go to the very beginning</td>
</tr>
<tr>
<td>CTRL+INSERT</td>
<td>X</td>
<td></td>
<td>Copy</td>
</tr>
<tr>
<td>CTRL+NUM-</td>
<td>X</td>
<td></td>
<td>Zoom out</td>
</tr>
<tr>
<td>CTRL+NUM+</td>
<td>X</td>
<td></td>
<td>Zoom in</td>
</tr>
<tr>
<td>CTRL+O</td>
<td>X</td>
<td></td>
<td>Open existing project</td>
</tr>
</tbody>
</table>
## 6.1 Project view user interface

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>TIA Portal / S7-PLCSIM</th>
<th>MS Windows</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+RETURN</td>
<td>X</td>
<td></td>
<td>Multiline text box: Insert line break without confirmation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Grid editor: Insert row above current</td>
</tr>
<tr>
<td>CTRL+S</td>
<td></td>
<td></td>
<td>Save</td>
</tr>
<tr>
<td>CTRL+SHIFT+ESC</td>
<td>X</td>
<td></td>
<td>Activate Task Manager</td>
</tr>
<tr>
<td>CTRL+SHIFT+F4</td>
<td>X</td>
<td></td>
<td>Close all editors</td>
</tr>
<tr>
<td>CTRL+SHIFT+F6</td>
<td>X</td>
<td></td>
<td>Previous open editor</td>
</tr>
<tr>
<td>CTRL+SHIFT+K</td>
<td>X</td>
<td></td>
<td>Screen keyboard</td>
</tr>
<tr>
<td>CTRL+SHIFT+RIGHT</td>
<td>X</td>
<td></td>
<td>Increase selection to the right (depends on context)</td>
</tr>
<tr>
<td>CTRL+SHIFT+S</td>
<td>X</td>
<td></td>
<td>Save as</td>
</tr>
<tr>
<td>CTRL+SPACE BAR+lasso with the mouse</td>
<td>X</td>
<td></td>
<td>Zoom to selected area - Device configuration</td>
</tr>
<tr>
<td>CTRL+UP</td>
<td>X</td>
<td></td>
<td>Jump up</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>X</td>
<td></td>
<td>Paste</td>
</tr>
<tr>
<td>CTRL+W</td>
<td>X</td>
<td></td>
<td>Close project</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>X</td>
<td></td>
<td>Cut</td>
</tr>
<tr>
<td>DELETE</td>
<td>X</td>
<td></td>
<td>Delete</td>
</tr>
<tr>
<td>DOWN</td>
<td>X</td>
<td></td>
<td>Move down</td>
</tr>
<tr>
<td>END</td>
<td>X</td>
<td></td>
<td>Go to the end</td>
</tr>
<tr>
<td>ESC</td>
<td>X</td>
<td></td>
<td>Stop/ cancel the current task or search, close dialog or drop down</td>
</tr>
<tr>
<td>F1</td>
<td>X</td>
<td></td>
<td>Starts the application's help system from most user interface areas</td>
</tr>
<tr>
<td>F12</td>
<td>X</td>
<td></td>
<td>Split the editor vertically</td>
</tr>
<tr>
<td>F2</td>
<td>X</td>
<td></td>
<td>Rename (PNV, Grid)</td>
</tr>
<tr>
<td>F4</td>
<td>X</td>
<td></td>
<td>Open drop-down</td>
</tr>
<tr>
<td>F6</td>
<td>X</td>
<td></td>
<td>Switches between basic frames of WB in top-to-bottom order</td>
</tr>
<tr>
<td>HOME</td>
<td>X</td>
<td></td>
<td>Go to the beginning</td>
</tr>
<tr>
<td>INSERT</td>
<td>X</td>
<td></td>
<td>Switches between insert mode and overwrite mode</td>
</tr>
<tr>
<td>LEFT</td>
<td>X</td>
<td></td>
<td>Move left</td>
</tr>
<tr>
<td>PAGE DOWN</td>
<td>X</td>
<td></td>
<td>Go one page down</td>
</tr>
<tr>
<td>PAGE UP</td>
<td>X</td>
<td></td>
<td>Go one page up</td>
</tr>
<tr>
<td>PRINTSCREEN</td>
<td>X</td>
<td></td>
<td>Copies an image of the screen onto the clipboard</td>
</tr>
<tr>
<td>RIGHT</td>
<td>X</td>
<td></td>
<td>Move right</td>
</tr>
<tr>
<td>SHIFT+DELETE</td>
<td>X</td>
<td></td>
<td>Cut</td>
</tr>
<tr>
<td>SHIFT+DOWN</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+F1</td>
<td>X</td>
<td></td>
<td>Starts the application's help system from most user interface areas</td>
</tr>
</tbody>
</table>
6.2 Using Undo and Redo in Project view

6.2.1 Overview of Undo and Redo

S7-PLCSIM supports undo and redo for many editing actions in the same way as in the TIA Portal.

Use the toolbar button 🔄 for undo and the ➡️ button for redo.

You can also use the following standard Windows shortcut key combinations:

- undo by using Ctrl+Z
- redo by using Ctrl+Y

The following sections provide details about the user interface areas and actions that support undo/redo, and the actions that specifically do not support undo/redo.

---

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>TIA Portal / S7-PLCSIM</th>
<th>MS Windows</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHIFT+F10</td>
<td>X</td>
<td></td>
<td>Open shortcut menu</td>
</tr>
<tr>
<td>SHIFT+HOME</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+INSERT</td>
<td>X</td>
<td></td>
<td>Paste</td>
</tr>
<tr>
<td>SHIFT+LEFT</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+PAGE DOWN</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+PAGE UP</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+RETURN</td>
<td>X</td>
<td></td>
<td>Multiline text box: Insert line break without confirmation</td>
</tr>
<tr>
<td>SHIFT+RIGHT</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>SHIFT+TAB</td>
<td>X</td>
<td></td>
<td>Jump backward</td>
</tr>
<tr>
<td>SHIFT+UP</td>
<td>X</td>
<td></td>
<td>Increase selection</td>
</tr>
<tr>
<td>UP</td>
<td>X</td>
<td></td>
<td>Move up</td>
</tr>
<tr>
<td>WINDOWS KEY</td>
<td>X</td>
<td></td>
<td>Activates start button menu</td>
</tr>
</tbody>
</table>
6.2.2 Clearing the Undo/Redo queue

The following actions clear the undo/redo queue:

- Saving an S7-PLCSIM project
- Closing an S7-PLCSIM project
- Downloading a STEP 7 program

Each project opens with an empty undo queue. The undo options remain disabled until you perform an undoable action.

Each instance of S7-PLCSIM has its own undo/redo queue. When two instances of S7-PLCSIM are open, the two instances are independent, so actions you take in one instance do not affect the other instances.

When S7-PLCSIM is in Project view without an open project, there are no undoable actions.

As you make edits that can be undone, those edits are added to the undo queue. The redo option is only available if your last action was an undo.

If you select to undo multiple actions, each of those actions is then listed in the redo queue. However, as soon as you make a new edit (a new undoable action), S7-PLCSIM empties the redo queue and then disables the redo option.

6.2.3 Interaction between Undo and Redo

As you make edits that cannot be undone, those edits are added to the undo queue.

The "redo" option only becomes available when you select to undo an action. If you select to undo multiple actions, each of those actions is then listed in the redo queue.

However, as soon as you make a new edit (a new undoable action), S7-PLCSIM empties the redo queue and then disables the redo option.

Redo is only available if your last action was an undo.
6.2.4 Undo and Redo in the main Project view window

The following table lists the actions in Project view that support undo/redo. The "undo/redo description" column is the text that appears in the drop-down list for the toolbar buttons.

<table>
<thead>
<tr>
<th>User Action</th>
<th>Undo/Redo Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main menu options:</td>
<td>Insert &quot;name&quot;</td>
<td>These allow copy/paste of project components (SIM tables and Sequences). The undo-able action is the paste of a new component.</td>
</tr>
<tr>
<td>• &quot;Edit &gt; Cut&quot;</td>
<td></td>
<td>This also allows copy/paste of selections in an editor (selected rows). For these, the undo/redo description should match what is defined for these actions in the specific editor.</td>
</tr>
<tr>
<td>• &quot;Edit &gt; Copy&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Edit &gt; Paste</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Related toolbar buttons:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Cut&quot; button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Copy&quot; button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Paste&quot; button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Main menu options:</td>
<td>Delete &quot;name&quot;</td>
<td>This supports deleting a project component (SIM table or Sequence).</td>
</tr>
<tr>
<td>• &quot;Edit &gt; Delete</td>
<td></td>
<td>This also supports deleting selections in an editor (selected rows). For these, the undo/redo description should match what is defined for these actions in the specific editor.</td>
</tr>
<tr>
<td>*Related toolbar button:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>• &quot;Delete&quot; button</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Main menu option:</td>
<td>Rename &quot;name&quot;</td>
<td>This allows you to rename a project component (SIM table or Sequence).</td>
</tr>
<tr>
<td>&quot;Edit &gt; Rename&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>&quot;Add new SIM table&quot; from project tree</td>
<td>Add new &quot;name&quot;</td>
<td></td>
</tr>
<tr>
<td>&quot;Add new sequence&quot; from project tree</td>
<td>Add new &quot;name&quot;</td>
<td></td>
</tr>
<tr>
<td>Renaming project component (SIM table or sequence) from project tree</td>
<td>Rename &quot;name&quot;</td>
<td></td>
</tr>
<tr>
<td>Deleting project component from project tree</td>
<td>Delete &quot;name&quot;</td>
<td></td>
</tr>
</tbody>
</table>
The following table lists the actions in Project view that do not support undo/redo.

<table>
<thead>
<tr>
<th>User Action</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>All actions in the main menu &quot;Project&quot;</td>
<td>Undo/Redo not supported for project actions.</td>
</tr>
<tr>
<td>Related toolbar buttons:</td>
<td></td>
</tr>
<tr>
<td>• &quot;New project&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Open project&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Save project&quot; button</td>
<td></td>
</tr>
<tr>
<td>Main menu option:</td>
<td></td>
</tr>
<tr>
<td>• &quot;Edit &gt; Open object&quot;</td>
<td>Switching between Project views is not undoable.</td>
</tr>
<tr>
<td>Main menu options:</td>
<td></td>
</tr>
<tr>
<td>• &quot;Execute &gt; Start CPU&quot;</td>
<td></td>
</tr>
<tr>
<td>• &quot;Execute &gt; &quot;Stop CPU&quot;</td>
<td></td>
</tr>
<tr>
<td>Related toolbar buttons:</td>
<td>These are online actions.</td>
</tr>
<tr>
<td>• &quot;Place CPU in Run mode&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Place CPU in Stop mode&quot; button</td>
<td></td>
</tr>
<tr>
<td>Main menu:</td>
<td></td>
</tr>
<tr>
<td>• &quot;Tools &gt; Start recording&quot;</td>
<td>Recording actions are not undoable.</td>
</tr>
<tr>
<td>• &quot;Tools &gt; Stop recording&quot;</td>
<td></td>
</tr>
<tr>
<td>• &quot;Tools &gt; Pause recording&quot;</td>
<td></td>
</tr>
<tr>
<td>Related toolbar buttons:</td>
<td></td>
</tr>
<tr>
<td>• &quot;Start recording&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Stop recording&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Pause recording&quot; button</td>
<td></td>
</tr>
<tr>
<td>All actions in the main menu:</td>
<td>Window actions are not undoable.</td>
</tr>
<tr>
<td>• &quot;Window&quot;</td>
<td></td>
</tr>
<tr>
<td>Related toolbar buttons:</td>
<td></td>
</tr>
<tr>
<td>• &quot;Switch to Compact view&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Split editor horizontally…&quot; button</td>
<td></td>
</tr>
<tr>
<td>• &quot;Split editor vertically…&quot; button</td>
<td></td>
</tr>
<tr>
<td>All actions in the main menu &quot;Help&quot;</td>
<td></td>
</tr>
<tr>
<td>Switching between editors from the project tree or application frame</td>
<td>Switching between SIM table and Sequence editors is not undoable.</td>
</tr>
</tbody>
</table>

### 6.2.5 Undo and Redo under Project view main menu > Options > Settings

None of the actions under Main menu > Options > Settings support undo and redo. TIA Portal behaves in the same way.
6.3 Working with projects

S7-PLCSIM stores all project data in a unique project folder. Each S7-PLCSIM project stores the following information:

- The hardware configuration as downloaded from STEP 7
- The program as downloaded from STEP 7
- S7-PLCSIM SIM table(s) and sequence(s)

Creating a project

To create a new project, go to "Project > New" from the main menu or main toolbar in Project view, or from the toolbar in Compact view.

S7-PLCSIM V15 projects have the file extension ".sim15".

By default, a new project contains one SIM table named "SIM table_1" and one sequence named "Sequence_1". You can rename these tables if you want to do so.

Naming a project

S7-PLCSIM automatically creates a unique, generic name for your project, such as "Project23.sim15". You can rename a project as long as the new name is unique.

Storing a project

When you create a new project, S7-PLCSIM automatically suggests a storage location for the project. You can view your project's current storage location by right-clicking the project name in the project tree and selecting "Properties".

To change the default project storage location, follow these steps:

1. Go to "Options > Settings" on the main menu.
2. Select the check box for "Default storage location" in the "Storage settings" area.
3. Type the storage path, or browse to it and select it.
4. Click the "OK" button when you are finished.
Opening a project

Select "Project > Open" to open an existing project. You can select a project from the list of recent projects, or browse to the project you want to open.

Note

S7-PLCSIM versions and projects

You can open an S7-PLCSIM V14 SP1 project from S7-PLCSIM V15. When you do so, the project is converted into an S7-PLCSIM V15 project.

You cannot use S7-PLCSIM V14 or S7-PLCSIM V14 SP1 to open an S7-PLCSIM V15 project.

Saving a project

To save your project with its current name and storage location, go to "Project > Save" or "Project > Save as...". You can accept the default name and location, or change either or both before you save.

Note

Saving during a STEP 7 download

You cannot save a project during a download from STEP 7 because "Save" and "Save as..." are disabled until the download completes.

Opening a saved project

Your saved project opens with the same configuration it had when it was saved, including the hardware configuration and STEP 7 program, SIM tables, sequences, and workspace layout.

Deleting a project

To delete a project, select "Project > Delete project" and then select the project you want to delete.

You can also use Windows Explorer to browse to your project's storage location and delete it from there.
Project properties

To view your project's properties, right-click the project name in the project tree and select "Properties".

The Project properties dialog box displays information about your project as follows:

<table>
<thead>
<tr>
<th>Category</th>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project</td>
<td>Name</td>
<td>Current project name.</td>
</tr>
<tr>
<td></td>
<td>Creation time</td>
<td>Date and time the project was created.</td>
</tr>
<tr>
<td></td>
<td>Last change</td>
<td>Date and time the project was last modified.</td>
</tr>
<tr>
<td></td>
<td>Author</td>
<td>Project author. Defaults to your Windows user name.</td>
</tr>
<tr>
<td></td>
<td>Comment</td>
<td>You can add comments for your project here.</td>
</tr>
<tr>
<td>Details</td>
<td>Storage location</td>
<td>Path to your project's storage location.</td>
</tr>
<tr>
<td></td>
<td>Size in KB</td>
<td>Size of your project in kilobytes.</td>
</tr>
</tbody>
</table>

You can edit the "Author" field by typing over the default name.

You can add comments about your project in the "Comment" field if you want to do so.

Information in the other fields cannot be changed.
6.4 Project view: simulation and project states

6.4.1 Simulations and projects are separate actions
As of S7-PLCSIM V15, creating a project and starting a simulation are two distinct actions:

- Open, create, edit, save, or delete a project. You must be in Project view to take these actions.
- Start a simulation. You can start a simulation from either Project view or Compact view.

6.4.2 Overview of project and simulation states
Generally speaking, Project view displays in one of the following states:

- No open project and no running simulation
- No open project and a running but unconfigured simulation
- No open project and a configured simulation
- Project is open with no running simulation
- Project is open with a running but unconfigured simulation
- Project is open with a running, configured simulation
6.4.3 No open project and no running simulation

The following screenshot shows Project view when there is neither an open project nor a running simulation:

Only the following options are available in this state:

- Create a new project
  - Note that you do not need to select a "simulation family" when you create a project.

- Open an existing project
  - Note that opening an existing project might or might not start a simulation. If you previously saved the project with a running simulation, then that simulation is restarted. If you saved the project without a running simulation, Project view opens without a running simulation.

- Select a CPU family for simulation and then start a simulation
  - After selecting the CPU family from the main toolbar and then click the power button to launch a simulation.

- Switch to Compact view
6.4.4 No open project and a running but unconfigured simulation

Project view changes very little if you have selected to start a simulation by clicking the power button, but have not yet configured the simulation with a download from the TIA Portal. The power button turns green to indicate a running simulation. The RUN/STOP buttons remain disabled.

However, S7-PLCSIM now appears as a target for download from the TIA Portal. You can then download and debug your program and hardware configuration in the TIA Portal.

In this state, the following options are available:

- Create a new project
  - Creating a new project when there is a running simulation causes the new project to attach to the already-running simulation.

- Open an existing project
  - Opening an existing project does not terminate the running simulation. Your opened project might or might not contain a simulation. If the project you open does not contain a simulation, your existing simulation is closed before the project is opened.

- Use the power button to terminate the simulation
  - Switching the power button to the off state terminates the running simulation.

- Switch to Compact view
6.4.5 No open project with a configured simulation

After you configure your simulation with a download from the TIA Portal, the Project view displays enabled RUN/STOP buttons.

In this state, the following options are available:

- Create a new project
  - Creating a new project when there is a running simulation causes the new project to attach to the already-running simulation.

- Open an existing project
  - Opening an existing project terminates the running simulation. Your opened project might or might not contain a simulation. If the project you open does not contain a simulation, your existing simulation is closed before the project is opened.

- Use the power button to end the simulation

- Switch to Compact view
6.4.6 Project is open with no running simulation

If you select to create a new project but have not started a simulation, Project view appears as follows:

With an open project, you can create and edit SIM tables and sequences. The project tree shows that there is no running simulation. Project view displays an unconfigured CPU of the currently selected CPU family.

You can start a simulation for this project by selecting the family of the CPU you want to simulate and then clicking the power button on. When you do this, the project and the running simulation are connected.

You can save the S7-PLCSIM project without starting a simulation. When you re-open the project, the Project view appears as it does in the screenshot above.
6.4.7 Project is open with a running but unconfigured simulation

If you have created, or opened a project and started a simulation, the Project view appears as follows:

The Project tree displays the simulation with a default name and type. The power button is green to indicate a running simulation for the current CPU family. The simulation has not been configured by a download from STEP 7. Switching to Device configuration displays an unconfigured CPU for the currently selected family.
6.4.8 Project is open with a running, configured simulation

In this state, there is an open project with a running simulation that has been configured with a download from the TIA Portal. Project view displays in its fully-functional state.

You can see that Project view has gone online. The simulation status displays in the project tree, along with the name and family of the configured CPU.
6.5 Visual feedback regarding online and offline states

The S7-PLCSIM Project view provides visual feedback of online status when there is an active connection to the simulated PLC. Two changes occur in Project view when S7-PLCSIM is online:

- Parts of the user interface are colored orange
- An animation appears in the lower right corner of the application:

6.6 Working in Device configuration view

6.6.1 Overview of Device configuration view

Device configuration contains two sections:

- Configured hardware
- Addresses

Configured hardware

S7-PLCSIM provides the Device configuration view so you can visualize the hardware configuration you download for your simulation. This view provides a read-only view of your hardware.

You cannot make any changes to your hardware in Device configuration. If you want to modify your hardware configuration, you must do so in STEP 7 and then download it to S7-PLCSIM in order to simulate your new hardware configuration.

Addresses

When you select a device in the hardware section, the Addresses section displays entries for each IO channel of the device.
6.6.2 Device configuration user interface

The Device configuration view contains two sections:

1. A Device configuration that displays the hardware that you downloaded from STEP 7.
2. An Addresses section that displays all of the possible addresses for your input and output devices, as well as a subset of the SIM table that allows you to monitor and modify values without switching to the full SIM table editor.

Device configuration

The Device configuration displays the hardware you downloaded from STEP 7. The Device configuration is for display purposes only. You cannot alter the Device configuration in S7-PLCSIM.

Modules that are functioning properly display a green checkmark. Modules with faults display a fault icon. The CPU displays a RUN or STOP icon depending on its state. This is the same display that appears in STEP 7.

Controls

The toolbar in the configured hardware section is similar to the controls in the STEP 7 Device configuration:

- Button to toggle module names
- Button to select zoom in, zoom selection, and zoom out
- Drop-down list box to indicate zoom percentage
Addresses

Device configuration also contains an Addresses section that includes a subset of the SIM table (the Name, Address, Display format, and Monitor/Modify value columns).

6.6.3 Device configuration sections

6.6.3.1 Configured hardware section

Overview of the configured hardware section

Every time a download from STEP 7 completes, the configured hardware section of Device configuration view automatically updates to display the downloaded hardware configuration. The configured hardware section displays device names just as it does in the STEP 7 Device configuration section.

Supported hardware

S7-PLCSIM accepts, without error, download of any supported S7-1200, S7-1500, or ET 200SP Device configuration. However, you might not be able to simulate devices that S7-PLCSIM does not recognize. Unrecognized devices are omitted from the Device configuration view.

Unrecognized hardware

It is possible that your STEP 7 installation might support newer hardware that Device configuration does not recognize. This can occur if STEP 7 has been updated with a hardware support package (HSP).

Hardware installed with an HSP (hardware support package)

If you have installed devices with a hardware support package, it is possible that those devices might not appear in Device configuration.

Undo and Redo in the configured hardware section

The configured hardware section of Device configuration does not support any actions with Undo/Redo. The hardware section of Device configuration is "read-only".
Downloaded central and decentral hardware display

The configured hardware section of Device configuration view displays details of the hardware that you download from the TIA Portal to S7-PLCSIM.

The configured hardware section is designed to display both central and decentral (remote) modules.

Even if S7-PLCSIM is not able to display the hardware configuration for a device, you can manually enter addresses for that device in the Addresses section of Device configuration or in the SIM table.

Features of the Device configuration view

There are no editing options provided in the Device configuration view. The purpose of this view is to provide status and debugging information for your hardware configuration. If you need to edit your hardware configuration, you must do so in STEP 7.

Device status indicators

S7-PLCSIM displays icons to indicate the online status of a device. This information is exactly the same as displayed in the TIA Portal STEP 7 Device configuration in online mode.

Displaying tags for IO addresses

S7-PLCSIM learns the tags you have defined for your program after you perform a download. The Device configuration displays tag names of the IO channels of recognized devices in the same manner as in the TIA Portal STEP 7 Device configuration.

Zoom factor

The Device configuration toolbar contains controls for zooming in and out when you view your hardware configuration. These controls function in the same way as in the TIA Portal STEP 7 Device configuration.
6.6.3.2 Addresses section

Overview of the Addresses section

Device configuration contains a pull-out section that displays an entry for each IO channel for a device you have selected in the hardware configuration section. This Addresses section functions as a subset of the SIM table editor, and allows you to view and set values for IO channels.

You can select and work with the IO channels for one, or multiple, devices in the hardware configuration section:

Undo and Redo in the Addresses section

The Addresses section of Device configuration view supports reading and writing data to the IO channels of a selected device. It is not possible to undo or redo these actions.

6.6.4 Undo and Redo in Device configuration

S7-PLCSIM provides the Device configuration so that you can visualize the downloaded hardware configuration for the simulation. This provides a "read-only" view of your configured hardware. You cannot edit anything in the configured hardware section of Device configuration, and therefore undo and redo are not relevant.
6.6.5 **Device configuration view before a STEP 7 download**

If you have created or opened a project but not yet performed a download from STEP 7, Device configuration view displays a generic PLC. The generic PLC has a label that reads "PLC Powered Off" if the PLC is powered off, and "Unconfigured PLC" if the PLC is powered on.

6.6.6 **Device configuration view after a STEP 7 download**

After you configure your simulation by performing a download from STEP 7, or when you open a project that contains a configured CPU:

- the hardware configuration section of Device configuration view displays the name and model of the downloaded PLC
- the addresses section displays the onboard addresses for the downloaded PLC

6.7 **Features common to both SIM table and Sequence editors**

6.7.1 **Overview of common features**

S7-PLCSIM has two grid-based editor views: SIM table and sequence. These two views have many consistent features between them. The following sections describe functions in common with both the SIM table and Sequence editors.
6.7.2 Common clipboard actions

S7-PLCSIM editors support standard clipboard actions (cut/copy/paste) for the following:

- Text within a cell
- Cell contents
- Single rows (entire row selections)
- Multiple rows (where rows are contiguous or not)

You can select clipboard actions in the following ways:

- Using standard Windows shortcut keys:
  - Ctrl+C for copy
  - Ctrl+X for cut
  - Ctrl+V for paste

- Shortcut menu provided in each editor; accessible by right-clicking in the editor

- The "Edit" menu on the main toolbar

Clipboard actions initiated in any of these ways have identical behavior according to standard Windows behavior.

Selecting multiple rows for clipboard actions

S7-PLCSIM supports selecting multiple rows for clipboard actions, generally in the same way that Windows does.

You can select multiple rows in the following ways:

- Left-click on the selection column for a row, then drag the mouse downward or upward to select multiple contiguous rows.
- Click the selection column for a row, then press and hold the Shift key and click another row (above or below the original) to select all the rows between the two clicks.
- To select multiple noncontiguous rows, click the selection column for a row, then press and hold the "Ctrl" key while selecting other rows. All the clicked rows then become part of the selection.
6.7 Features common to both SIM table and Sequence editors

6.7.3 Adding, editing, and deleting rows

The S7-PLCSIM views are designed so that you will always have an “empty row” in which to add new entries to a SIM table or Sequence. S7-PLCSIM supports adding or inserting empty rows at any valid location in the editor.

- Selecting “Add row” causes a new, empty row to be added immediately below the row with current editing focus.
- Selecting "Insert row" causes a new, empty row to be added immediately above the row with current editing focus.
- If you have selected multiple rows and these rows have focus, "Add row" causes the new row to be added below the first selected row and "Insert row" causes the new row to be added above the first selected row. Note that both of these options might not always be available in the sequence editor, due to the special nature of the first and last rows in that editor.

The S7-PLCSIM views also support deleting one or more rows from the editors. Once you have selected the row(s) using any of the methods described above, you can delete the row(s) using the normal keyboard or menu commands.

6.7.4 Applying tags for addresses

After a download from STEP 7, S7-PLCSIM inspects the downloaded program for tag information. It should be noted that if you change tag information in a SIM table, sequence, or Device configuration, these changes do not flow back "upstream" to STEP 7.

Each time a download from STEP 7 occurs, S7-PLCSIM updates tag information that has been changed in STEP 7 since the last download, based on the following rules:

- If an editor row contains only an address and not a name and the updated tag information contains a name for that address, the entry automatically updates to display both the tag name and the address.
- If the editor row contains an undefined tag (which displays as an error) and the updated tag information contains a definition for this tag name, the entry is automatically updated to display the information for this tag, and the error condition will be cleared.
- If the editor row contains a tag name and its associated address, and the updated tag information does not contain a tag for this address, then the address information for the entry is preserved. The tag name you entered is removed.
- If the editor row contains a tag name and its associated address, and the updated tag information contains a different tag name for that address, the tag name is automatically updated.
### 6.7.5 Auto-completion for tags

To help you enter tag names, S7-PLCSIM supports an "auto completion" mechanism for tag names. Auto-complete examines the text you input and then provides a list of tag names that match the text.

As an example, consider the following tag table defined in STEP 7:

![Tag Table Example](image)

When you download this project to S7-PLCSIM, S7-PLCSIM learns the tags from the downloaded tag information. You can then use the updated information in a SIM table or a sequence.

As you enter a tag name, auto complete attempts to match the entered text with previously defined tags. For example, if you enter the text "In" in a SIM table or sequence, the following tag choices automatically appear:

![Sim Table Example](image)

You can use the arrow keys to scroll the list, and then the Enter key to make a selection. When you select a tag from the list, the appropriate address and default display format are automatically set for the entry.
Auto complete also works for data blocks and user-defined data types. When you perform a download to S7-PLCSIM, the data block structures and user-defined data types are learned in the same way that tags and addresses are learned. These entries are valid in a SIM table or a sequence, and auto complete functions for these elements.

6.7.6 Common row indicators

6.7.6.1 Overview of the common row indicators

There are several row indicator icons that are common to both the SIM table and sequence editors:

- Errors
- Forced addresses
- Fail-Safe modules and the tags associated with them

6.7.6.2 Error indicator

Whenever invalid data exists in an editor; it is marked as an error.
Cells containing invalid data are colored pink, and the row containing invalid data is marked with an ✗ error icon.

6.7.6.3 Force indicator

A "force icon" displays for forced addresses that you download from STEP 7. It is the same icon as the one used in STEP 7. The icon displays for both fully- and partially-forced addresses. The icon displays in the following locations:

- SIM table rows that contain a fully- or partially-forced address downloaded from STEP 7.
- Sequence steps that contain a fully- or partially-forced address downloaded from STEP 7. However, if you disable the sequence step, the force icon does not display.
- Device configuration addresses that contain a fully- or partially-forced address downloaded from STEP 7.

6.7.6.4 Fail-Safe indicator

In S7-PLCSIM, Fail-Safe IO addresses are displayed with the same yellow Fail-Safe coloring as in the TIA Portal.
This is true wherever Fail-Safe addresses are used:

- SIM table editor
- Sequence editor
- Addresses section of Device configuration view
6.8 Working in the SIM table editor

6.8.1 Overview of working in the SIM table editor

The S7-PLCSIM SIM table editor enables you to modify simulated inputs and read simulated outputs. It is similar to a STEP 7 watch table, but the focus is on modifying peripheral inputs and reading peripheral outputs.

A simulation project can contain one or multiple SIM tables. You can run multiple SIM tables concurrently for the same simulated PLC.

Tag name and address display

As soon as you download a program from STEP 7, any open SIM table automatically begins monitoring specified tags and addresses.

Forced addresses

Forced values supersede typical S7-PLCSIM operations. Be aware that forced values might alter the behavior of your simulation.
6.8.2 SIM table editor description

The SIM table editor consists of two sections divided by a horizontal split view. The upper view contains the SIM table grid, or "Table view". S7-PLCSIM V15 introduces special controls in "Control view".

Table view

Table view in the SIM table editor is similar in design to a STEP 7 watch table:

S7-PLCSIM automatically assigns the name "SIM table_[n]" to a new SIM table, where [n] is the next unused number available.

A new project already contains one SIM table named "SIM table_1". Therefore, if you add a new SIM table, it is assigned the name "SIM table_2" by default.

You can rename a SIM table by right-clicking the name in the Project tree and selecting "Rename".

A simulation project can contain one or multiple SIM tables. Each SIM table must have a unique name.
## SIM table view toolbar

The icons on the SIM table view toolbar perform the following actions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert row</td>
<td>Inserts a new, empty row immediately above the current cursor position.</td>
<td></td>
</tr>
<tr>
<td>Add row</td>
<td>Inserts a new, empty row immediately below the current cursor position.</td>
<td></td>
</tr>
<tr>
<td>Modify all selected values</td>
<td>Writes values in the &quot;Consistent modify&quot; column for rows that have the check box selected to write those values in consistent, or batch, mode.</td>
<td></td>
</tr>
<tr>
<td>Enable/disable modification of non-inputs</td>
<td>By default, you can only write updates to inputs. When you click this button, you can also write updates to outputs, memory areas, and data block addresses. This button is only used to indicate an editing option - it is not an online action.</td>
<td></td>
</tr>
<tr>
<td>Export to Excel</td>
<td>Exports the contents of a SIM table in Microsoft Excel .xlsx file format.</td>
<td></td>
</tr>
<tr>
<td>Import from Excel</td>
<td>Imports the contents of a Microsoft Excel .xlsx file into a SIM table.</td>
<td></td>
</tr>
<tr>
<td>Load project tags</td>
<td>Loads all tags currently downloaded from your STEP 7 project into the open SIM table. This button is disabled if there are no currently downloaded tags.</td>
<td></td>
</tr>
<tr>
<td>Save window settings</td>
<td>Saves any changes you have made to the appearance of the SIM table editor, such as column widths. The saved settings also apply to new SIM tables that you create.</td>
<td></td>
</tr>
</tbody>
</table>
### SIM table view columns

The following table describes the SIM table view columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator (no column header)</td>
<td>This column shows information about your SIM table entry.</td>
</tr>
<tr>
<td></td>
<td>A purple tag icon appears in this column when a valid tag name is entered, or when you enter an address for a valid tag name from your downloaded STEP 7 program.</td>
</tr>
<tr>
<td></td>
<td>If you have a Fail-Safe tag, the purple tag displays on a yellow background just as it does in the TIA Portal.</td>
</tr>
<tr>
<td></td>
<td>A red &quot;X&quot; appears if there is an error with your entry. An error message will display.</td>
</tr>
<tr>
<td></td>
<td>A force indicator displays if the address is forced in any way. For example, a partially forced address displays the same force icon in the SIM table as a fully forced address.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the tag name.</td>
</tr>
<tr>
<td>Address</td>
<td>Displays the tag address.</td>
</tr>
<tr>
<td>Display format</td>
<td>Different display formats are available and depend on the type of entry. Some examples include Bool, Hex, and signed decimal (DEC +/-).</td>
</tr>
<tr>
<td>Monitor/Modify value</td>
<td>Displays the entry’s current value.</td>
</tr>
<tr>
<td>Bits</td>
<td>A series of check boxes (one box per bit) will display in the field if the address is a bit or byte address. From left to right, the bit order is: 7, 6, 5, 4, 3, 2, 1, 0.</td>
</tr>
<tr>
<td>Consistent modify</td>
<td>This value is written to the PLC when you click the &quot;Modify all selected values&quot; button.</td>
</tr>
<tr>
<td></td>
<td>Select the check box in this column if you want the values in the row to be modified when you click the &quot;Modify all selected values&quot; button on the toolbar.</td>
</tr>
<tr>
<td>Comment</td>
<td>You can add a comment here to provide documentation for the SIM table entry.</td>
</tr>
</tbody>
</table>

### SIM table view shortcut menu

When you right-click inside a SIM table, the following shortcut menu displays:
Control view

The SIM editor Control view contains two controls that you can use to easily adjust values:

- A slider for adjusting analog values
- A push button for adjusting Boolean values

Note that you can also adjust values in Table view.

The slider and push button controls are described in detail in the section "Working with analog and Boolean values in Control view" (Page 103).

Undo and redo button behavior in the SIM editor

The SIM table editor supports undo and redo for many actions you perform. However, some actions cannot be undone or redone.

Examples of actions that do not have undo and redo support include:

- Edit text for "Monitor/modify value"
- Clicking the "bits" checkboxes in Table view
- Modify all selected values (toolbar button)
- Export to Excel (toolbar button)
- Enable/Disable modification of non-inputs (toolbar button)

Note that additional actions, such as downloading a program from STEP 7, might erase the contents of the undo/redo queue.

6.8.3 Creating and populating a SIM table

6.8.3.1 Overview of creating and populating a SIM table

You have the following options for adding or inserting rows in a SIM table, or for creating an entire SIM table:

- Use auto fill to create additional rows based on a selected tag or address
- Copy and paste all, or a portion of, a STEP 7 tag table, watch table, or force table
- Drag and drop a module from the hardware configuration section of the S7-PLCSIM Device configuration view
- Import all or a portion of, a STEP 7 tag table, watch table, or force table using Microsoft Excel
6.8.3.2 SIM table: load project tags from STEP 7

You can use the "load project tags" button on the SIM table editor toolbar to load your STEP 7 tags into an open SIM table.

Clicking this button loads all of the tags from your most current STEP 7 download.
If there are no tags from the most current download, the "load project tags" button is disabled.

6.8.3.3 Using auto fill in the SIM table

You can populate your SIM table by using auto fill. SIM table auto fill works in the same way as in a STEP 7 watch table.

You must have at least one row already entered for auto fill to use as a basis for incrementing addresses.

After a download, you can also use auto fill with the "Name" field.

Auto fill procedure

Use the following procedure to auto fill rows in a SIM table:

1. Enter an address in the SIM table "Address" field. A small blue square appears on the bottom right corner of the field.

2. Hover over the blue square. A plus sign ("fill handle") appears. Click and hold the mouse button while you drag straight down to fill the number of addresses you want to add.

3. Addresses are added in sequential order according to the selected tag. For example, beginning with "I0.0" as the selected address and auto filling three rows adds I0.1, I0.2, and I0.3.

4. If there are already entries in the cells you select to auto fill, the "AutoFill" dialog displays. Select "Overwrite existing elements" or "Insert elements".
6.8 Working in the SIM table editor

6.8.3.4 Monitoring and modifying values in table view

The "Monitor/Modify value" column displays the current value in the format you selected in the "Display format" column. You can modify values in the SIM table either individually, using this column, or in a consistent (batch) mode using the "Consistent modify" column.

Be aware that some SIM table values might only update if the virtual PLC is in RUN mode.

Bit and byte value display

If the address is a bit address, one check box appears in the "Bits" column.

If the address is a byte address, eight check boxes (one check box per bit) appear in the "Bits" column. The order of the bits, from left to right, is: 7, 6, 5, 4, 3, 2, 1, 0.

The following image shows the check boxes for four SIM table rows, two with bit addresses and two with byte addresses:

Expanding byte addresses

When you enter a byte address, a triangle icon appears beside the name of the entry. The triangle icon indicates that you can expand the entry.

When you click the triangle icon, the byte address expands to show separate entries for each bit in the byte. The names and addresses for these "expanded" entries are read-only.

Note

The SIM table continues to monitor and update even as you enter new values.

Modifying non-input addresses

By default, you can only write values to inputs. The SIM table editor toolbar button allows you to also write values to outputs, memory, timer, counter, and data block addresses.

Modifying individual values

Use the "Monitor/modify value" and "Bits" fields to enter a value that writes immediately to the simulated PLC.

To modify a value individually and immediately, simply enter the new value in the "Monitor/modify value" field.

You can use the individual check boxes in the "Bits" field to immediately change the values of individual bits in a byte address. There is one check box per bit. An empty check box indicates a 0, or FALSE, value. A selected check box indicates a 1, or TRUE, value.
Modifying values in a consistent (batch) mode

You can update multiple values concurrently by entering the new values in the "Consistent modify" fields.

Select the check boxes for the fields you want to modify in the column headed by the "lightning bolt" icon:

A yellow triangle indicates that a value will be applied when you click the "Modify all selected values" button 🛠 on the toolbar. The button writes data for all the checked entries containing a modified value. If you do not have an active connection to the simulated PLC and click this button, a warning message appears.

6.8.3.5 SIM table: copy and paste tags and tables from STEP 7

You can copy and paste one tag, several tags, or all tags from a STEP 7 tag table, watch table, or force table to an S7-PLCSIM SIM table.

Before a download, you can copy and paste tag addresses from STEP 7. After a download, you can copy and paste either tag addresses or tag names from STEP 7.

Copying and pasting structured tags

S7-PLCSIM pastes structured tags in a different way. When you copy a structured tag, the cell turns red. Click the cell, add a period to the end of the tag name, and a dropdown list displays all of the tag's subnodes. You can then select the subnode tags to paste and use in S7-PLCSIM.

When you copy a structured tag, the cell turns red. Click the cell, add a period to the end of the tag name, and a dropdown list displays all of the tag's subnodes. You can then select the subnode tags to paste and use in S7-PLCSIM.
Copy and paste procedure

Use the following procedure to copy and paste tags from STEP 7 to S7-PLCSIM:

Result: the STEP 7 tags are added to the SIM table.

1. Select one or more tag names, tag addresses, or both in a STEP 7 tag table, watch table, or force table. You can use the Shift key to select sequential tags, or use the Ctrl key to select non-sequential tags.

2. Use Ctrl-C, or right-click and select "Copy" from the shortcut menu.

3. Select a tag name field, tag address field, or both tag name and tag address fields in the SIM table.

4. Use Ctrl-V, or right-click and select "Paste" from the shortcut menu.

Result: the STEP 7 tags are added to the SIM table.

---

Note

Cut and paste vs. copy and paste

When you perform a cut and paste operation between two open instances of S7-PLCSIM, the data from the source instance is copied instead of being cut.

In order to work around this behavior, delete the cut or copied rows from the source instance.

---

6.8.3.6 SIM table: import and export using Microsoft Excel

The S7-PLCSIM export button allows you to export an existing SIM table in .xlsx format that can then be imported into another SIM table within the same project, or imported into a SIM table in a different project.

The import button allows you to create or expand a SIM table by importing an .xlsx file that contains:

- The contents of a different SIM table
- The contents of a STEP 7 tag table, watch table, or force table
Export and import procedure

Export a table from STEP 7 to a Microsoft Excel file:
1. Select tags in a STEP 7 tag table, watch table, or force table. Note that the entire table is exported no matter how many tags you select.
2. Right-click and select "Export" from the shortcut menu.
3. Select a location and name for the exported Excel file.
4. Click "Open".
Result: the entire table is exported with the name and location you entered.

Import a table from a Microsoft Excel file into a SIM table:
1. Open a SIM table.
2. Select the "Import" button from the SIM table toolbar, or select "Import from Excel" from the SIM table shortcut menu.
3. Locate the Excel file you want to import. Note that the import file must be closed for the import to work correctly.
4. Click "Open".
Result: the .xlsx file contents appear in your SIM table.

Note
Imported files with empty address fields
If your .xlsx file contains one or more empty address fields, a warning message displays that the import was only partially successful. An error icon displays in the status indicator column for a row that contains an empty address field.
6.8.3.7 Drag and drop a module from Device configuration to create a SIM table

S7-PLCSIM supports populating a SIM table by dragging a device from Device configuration view and dropping it onto the SIM table. You can facilitate this process by having both Device configuration view and the SIM table editor visible at the same time in project view by clicking the "split window horizontally" button or by floating either editor window:

Here we have the Device configuration view and a SIM table visible at the same time. From the "Addresses" tab in Device configuration view, you see there are some tags defined for this device.

You can add SIM table entries for all the IO channels on the device by selecting the device in the graphical view; dragging it to the SIM table; and then dropping it.

If you select to drag and drop a module onto a SIM table that already contains entries, the new entries for the module are appended to the end of the SIM table.

After the drag and drop operation, there is no further link between the device and the SIM table. If changes for the Device configuration are downloaded to S7-PLCSIM (changes to the address mapping for the module, for example), these changes are not automatically reflected in the SIM table.

You can also select multiple devices in Device configuration view by holding the Ctrl key and clicking the modules you want to select. Dragging these multiple devices and dropping them onto a SIM table will populate the table with the IO address for all the selected devices.
6.8.3.8 Creating a new sequence from recorded SIM table editor actions

You can record actions you take in the SIM table editor to create a sequence, and then play back those actions by running the new sequence.

Procedure to create a new sequence from the SIM table editor

Follow these steps to create a new sequence from the SIM table editor:

1. Create a SIM table.
2. Perform a download from STEP 7.
3. Click the "Start recording" button on the main toolbar, or select "Start recording" from the Tools menu.
4. Enter actions in the SIM table section, such as adding and deleting entries, and changing values individually or in consistent (batch) mode.
5. If you want to pause while you are recording your actions, click the "Pause recording" button on the main toolbar, or select "Pause recording" from the Tools menu.
6. To resume recording, click or select "Pause recording" again. When you are finished recording your actions, click the "Stop recording" button on the main toolbar, or select "Stop recording" from the Tools menu.

Result: a new sequence is created from your recorded actions and appears in the Sequences folder with a default name. You can rename the sequence if you prefer to do so.

6.8.4 Working with analog and digital values in control view

6.8.4.1 Overview of control view

When you work with your STEP 7 program, you might want to simulate a gradual ramp up or ramp down of an analog value, or simulate a momentary value change for a Boolean value.

S7-PLCSIM V15 provides an easy way to adjust these values with two new controls.

SIM editor Table view and Control view

The SIM editor is horizontally divided into two views:

- Table view is the upper part of the editor and contains the SIM table grid and toolbar
- Control view is the lower part of the editor and contains a slider for adjusting analog values and a push button for adjusting Boolean values

You can manage the SIM editor workspace by resizing the Table view or the Control view, or by collapsing the Control view.
Displaying Control view

To display the Control view, you must select exactly one Table view row. If you select multiple rows, the Control view will be empty.

Control view also remains empty if you select a Table view row with non-numeric values, such as CHAR and TIME-OF-DAY.

Changing values in Control view

When you switch focus from one Table view row to another, Control view displays information related to your newly-selected row. When you select and edit a row, the information in Control view updates to reflect your edits.

Control view displays context sensitive controls based on the values in your Table view row selection:

- If there is an analog value in your selected Table view row, then Control view displays the slider control.
- If there is a Boolean value in your selected Table view row, then Control view displays the push button control.

6.8.4.2 The Control view slider for analog values

The SIM editor displays the analog slider control when you select a row which contains a numeric value. The value may be of any data width (BYTE, WORD, DWORD, QWORD).

The slider control is not displayed if a selected row does not contain a numeric value.

Updating analog values

When you are not directly controlling the slider by clicking and dragging the handle, the slider updates periodically to display the actual values in your simulation.

When you directly control the slider by clicking and dragging the handle, the corresponding value is written to the simulation periodically. The update rate is 5 Hz (200 ms). If you are recording a sequence, the values are recorded in the sequence.

You can operate the slider handle only by using a mouse. The slider does not support keyboard input.
Controlling the valid value range

Process values often have a limited range of validity. You can set a minimum and maximum value for the slider to reflect the valid range of values for each Table view row.

- The slider handle is in the leftmost position at the configured minimum of the valid value range.
- The slider handle is in the rightmost position at the configured maximum of the valid value range.

Note

Be aware that a sequence has a minimum allowable delay between steps, and the sequence editor will not accept a value below that minimum.

The slider displays the minimum and maximum values with the same data width and format as shown in the selected Table view row. For example, a Table view row containing a DWORD value displayed in HEX format will display in the same manner in the slider control. HEX format is treated as unsigned.

The slider accepts negative settings for signed values.

When the process value exceeds your configured limits, the slider control moves as much as it can - to the minimum or maximum end of the range - since it cannot indicate the actual value.

Slider range defaults

Minimum and maximum values for "integer-like" data types default to the minimum and maximum values for the given data width and format.

For example, if you have a memory address such as MW10 and choose HEX or Octal as the display format, S7-PLCSIM does not know if the address contains a signed or unsigned value. That address will therefore be treated as containing an unsigned value.

For signed integers, the minimum value will be negative.

Floating point values will default to a range minimum of 0.0 and a range maximum of 1.0.

Slider range persistence

Minimum and maximum values are persisted with the corresponding table row. When you save your project, each row's minimum and maximum values are saved.

When you cut or copy and then paste a row, the minimum and maximum values are pasted.

Minimum and maximum values are included when importing and exporting SIM table contents.
6.8.4.3 The Control view push button for Boolean values

The SIM editor displays the push button control in Control view when you select a row containing a Boolean value.

Push button use and behavior

The push button control operates much like a physical momentary push button. When you click and hold the button, the associated process value is modified. When you release the button, the process value is restored to its default state.

Like a physical push button, the button is write only. It is expected to have exclusive control of the process value. Therefore, the visual state of the button does not change to match the actual process value.

Note

If you change the value in another way, such as by running a sequence, the button might behave in an unexpected manner.

6.8.5 SIM table error conditions

The SIM table editor recognizes several error conditions. When an entry error occurs, the cell containing the error turns pink, a red "X" icon appears in the indicator column, and S7-PLCSIM does not gather data for that entry. However, all valid entries continue to monitor.

The following error conditions are recognized at the time of entry:

- Address is invalid (for example, syntactically incorrect)
- Address is out of range; that is, the address is too large for the physical memory of the hardware
- The Monitor/Modify value is out of range for the data type

Empty address field in imported file

If an imported Microsoft Excel .xlsx file contains one or more empty address fields, a warning message displays that the import was only partially successful. An error icon displays in the status indicator column for a row that contains an empty address field.
6.9  Working in the Sequence editor

6.9.1  Overview of working in the Sequence editor

The main purpose of a sequence is to simulate an external process interacting with your program. An external process interacts with the PLC through inputs. Any time you enter an input address (%I), it is automatically converted to a peripheral input address (%I:P) to more accurately simulate a signal from a physical wire.

Sequence editor and addresses

You can manipulate any of the following address areas within a sequence:

- Peripheral Inputs (%I:P)
- Outputs (%Q)
- Memory (%M)
- Data block (%DB)
- Timer (%T)
- Counter (%C)

With the sequence editor, you can define a set of timed value changes on inputs, outputs, and memory addresses. The sequence can be used to simulate the behavior of external devices on the running program. This allows you to observe the effect of your program logic and to make any adjustments that might be necessary.

A project can contain multiple sequences, but you can run only one sequence at a time. You might want to create multiple sequences to see the effect of various adjustments to your program logic rather than modifying a single sequence many times.

When you save your project, you save the sequences. You can replay them multiple times to assist in debugging your program.

When a sequence is no longer useful, you can delete it from your project.

A note about forced addresses

Forced values supersede S7-PLCSIM operations. Be aware that forced values might alter the behavior of your simulation.
6.9.2 Sequence editor description

S7-PLCSIM automatically assigns a name of "Sequence_[n]" to a new sequence, where [n] is the next unused number available. For example, the first sequence for your project is given the name "Sequence_1".

You can change the name of a sequence by right-clicking the name in the Project tree and selecting "Rename".

A simulation project can contain one or multiple sequences. Each sequence must have a unique name.

Sequence editor toolbar

The Sequence editor toolbar includes the following functions:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert step</td>
<td>Inserts a new empty step immediately above the currently selected step.</td>
</tr>
<tr>
<td>Add step</td>
<td>Inserts a new empty step immediately below the currently selected step.</td>
</tr>
<tr>
<td>Enable step</td>
<td>Enables a previously disabled step.</td>
</tr>
<tr>
<td>Disable step</td>
<td>Disables a step so it will be skipped when you run the sequence.</td>
</tr>
<tr>
<td>Step time adjustment</td>
<td>Adjusts the time of the selected steps by a specified time increment.</td>
</tr>
</tbody>
</table>
| Start sequence       | Plays the sequence from the beginning. The button is only available when the following conditions are true:  
                        • There are no other sequences currently running.  
                        • There are no errors in the sequence.  
                        You can also click this button to resume a paused sequence. |
| Stop sequence        | Immediately stops a running sequence.                                    |
### Button Function

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pause sequence" /></td>
<td>Pauses the sequence at the step that will execute next. You must click the “Start sequence” button to resume your paused sequence.</td>
</tr>
<tr>
<td><img src="image" alt="Repeat sequence" /></td>
<td>Loops your sequence until you manually stop the sequence.</td>
</tr>
<tr>
<td><img src="image" alt="Default interval and time format settings" /></td>
<td>Allows you to enter a time in milliseconds to increment the time in the “Time” column for newly added rows. The valid range is 0 - 3600000 ms. Use the time format settings to change the time format.</td>
</tr>
<tr>
<td><img src="image" alt="Export to Excel" /></td>
<td>Exports sequence to Excel format.</td>
</tr>
<tr>
<td><img src="image" alt="Import from Excel" /></td>
<td>Allows you to select to import either an Excel spreadsheet or a trace measurement file.</td>
</tr>
<tr>
<td><img src="image" alt="Execution time" /></td>
<td>Displays the total execution time for a running sequence, as well as the number of repetitions for a repeating sequence.</td>
</tr>
<tr>
<td><img src="image" alt="Save window settings" /></td>
<td>Saves any changes you have made to the appearance of the sequence editor, such as column widths and split windows. The saved settings also apply to new sequences that you create.</td>
</tr>
</tbody>
</table>
### Sequence editor columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Indicator (no column title)</td>
<td>This column displays icons to indicate the following information:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Icon" /> The first step in the sequence</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Icon" /> The last step in the sequence</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Icon" /> The step that is executing during playback</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Icon" /> An error in the sequence</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the time in hours:minutes:seconds.fractional seconds (00:00:00.00). The maximum time allowed is 23:59:59.95.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays the tag name.</td>
</tr>
<tr>
<td>Address</td>
<td>Displays the memory address affected by the step.</td>
</tr>
<tr>
<td>Display format</td>
<td>Different display formats are available and depend on the data type of the tag. For example, some of the available display formats include Bool, Hex, and floating-point number.</td>
</tr>
<tr>
<td>Action</td>
<td>For the first step in the sequence, the only option is &quot;Start sequence&quot;. For the last step in the sequence, you can:</td>
</tr>
<tr>
<td></td>
<td>• Stop the sequence</td>
</tr>
<tr>
<td></td>
<td>• Repeat the sequence</td>
</tr>
<tr>
<td></td>
<td>For action steps, you can select:</td>
</tr>
<tr>
<td></td>
<td>• Set to value</td>
</tr>
<tr>
<td></td>
<td>• Set to frequency (for input bit memory only)</td>
</tr>
<tr>
<td>Action parameter</td>
<td>Action parameters based on the Action column:</td>
</tr>
<tr>
<td></td>
<td>• For &quot;Set to value&quot;, you can enter a numerical value that is compatible with the entry’s data type.</td>
</tr>
<tr>
<td></td>
<td>• For &quot;Set to frequency&quot;, you can enter a frequency in Hertz.</td>
</tr>
<tr>
<td>Comment</td>
<td>You can add a comment here to provide documentation for the step.</td>
</tr>
</tbody>
</table>
Sequence editor rows (steps)

Each row in the Sequence editor represents a step in the sequence. The icons in the indicator column indicate the first and last step, which step is executing during playback, and whether a step has an error:

<table>
<thead>
<tr>
<th>Step and related icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start step</td>
<td>This is a fixed row that does not accept entries. It contains a time of &quot;00:00:00.00&quot;. There are two options in the Action column: Start immediately Trigger condition</td>
</tr>
<tr>
<td>Stop step</td>
<td>The last step in a sequence. The Action column contains the text &quot;Stop sequence&quot; or &quot;Repeat sequence&quot;.</td>
</tr>
<tr>
<td>Currently executing step</td>
<td>Indicates the step that will execute next. If you set the same execution time for more than one entry, all of the steps will show the green arrow.</td>
</tr>
<tr>
<td>Error indicator</td>
<td>Indicates that the step contains an error. A message displays information about the error.</td>
</tr>
</tbody>
</table>

Sequence editor context menu

Right-click anywhere in a step to display the following context menu:

- Insert step
- Add step
- Enable step
- Disable step
- Step time adjustment
- Cut Ctrl+X
- Copy Ctrl+C
- Paste Ctrl+V
- Delete Del
- Rename F2
- Start sequence
- Stop sequence
- Pause sequence
- Export to Excel
- Import from Excel
- Import from trace measurement

The behavior of these context menu commands is the same as the behavior for the toolbar commands.
6.9.3 Breakpoint functionality

S7-PLCSIM V15 supports breakpoints for S7-1500 and ET 200SP CPUs. When your STEP 7 program triggers a breakpoint, the simulated CPU enters the HOLD operating mode and your simulation stops executing.

Breakpoint behavior in a sequence

If you have a sequence running when a breakpoint triggers:

- the sequence pauses while the CPU is in HOLD mode
- the Play, Pause, and Stop commands are disabled

The paused sequence resumes when the CPU exits HOLD mode.

Visual feedback during HOLD mode

The PLCSIM user interface provides visual feedback to show that the CPU is in HOLD mode.

- In Compact view, the LEDs flash in the same pattern as a real CPU.
- In Project view:
  - If you have created a project in S7-PLCSIM, an icon appears next to the PLC in the project tree just as it does in the TIA Portal project tree.
  - However, if you have not created a project in S7-PLCSIM, there is no visual feedback to indicate that the CPU is in HOLD mode.
6.9.4 Undo and Redo in the Sequence editor

The Sequence editor supports undo and redo for many actions you perform. However, some actions cannot be undone or redone.

Examples of actions that do not have undo and redo support include:

- Export to Excel (toolbar button)
- Play sequence (from toolbar button or shortcut menu)
- Stop sequence (from toolbar button or shortcut menu)
- Pause sequence (from toolbar button or shortcut menu)
- Sorting columns
- Selecting or deselecting "Repeat sequence" (from toolbar button)
- Edit execution time

Note that additional actions might also erase the contents of the undo/redo queue.

Undo and Redo during sequence playback

Undo and redo are disabled when a sequence is playing or paused. This is true even when the playing sequence does not have the editing focus or when the playing sequence is not visible.

When the playing sequence ends or you explicitly stop it, undo and redo again become enabled. Any editing actions you perform during sequence playback will be visible in the undo queue.

6.9.5 Creating and populating a sequence

6.9.5.1 Overview of creating and populating a sequence

In addition to manually creating sequences and then entering and editing steps, there are several more "automated" methods for performing tasks in the Sequence editor:

- Use auto fill to create additional steps based on a selected address or tag name
- Create a new sequence from recorded SIM table editor actions
- Copy and paste all, or a portion of, a STEP 7 tag table, watch table, or force table
- Import all, or a portion of, a STEP 7 tag table, watch table, or force table using Microsoft Excel
- Import a trace measurement file from STEP 7 to create a sequence
6.9.5.2 Working with a sequence created from a SIM table recording

When you open a sequence that was created from actions that you recorded in the SIM table editor, you will see that the times for the sequence steps match the times for the actions you entered in the SIM table editor.

You can use the sequence the way it is, or adjust the times in the "Time" column for individual steps.

To play back a recorded sequence, simply click the "Start sequence" button.

6.9.5.3 Sequence: using auto fill

Using auto fill with a sequence works in a different way than it works in a SIM table. In a sequence, it is more useful to use auto fill to copy the contents of the auto filled cell than to increment that cell. You can then apply different start times to the same address to see the effect on your program.

Before download, you can use the Address field as the starting field for auto fill. After download, you can use either the Name or Address field for auto fill.

Auto fill behavior and the last sequence step

If you have defined a time for the last step in the sequence and auto fill would result in exceeding that time because of the Default interval, S7-PLCSIM automatically adjusts the time for the last step when you perform the auto fill.

Auto fill and the Default interval time

Before auto filling starts, the time in the Default interval is read. The Default interval value is 50 ms, and you cannot have a Default value less than 50 ms. The auto fill process uses this time to increment the time in the auto filled steps. Each auto filled step will have the same address as the field you selected as the basis for auto fill.
6.9.5.4 Sequence: copy and paste tags and tables from STEP 7

You can copy tags from STEP 7 and paste them into an S7-PLCSIM sequence, but there are differences from the way copy and paste works in a sequence and in a SIM table.

Copying and pasting structured tags

S7-PLCSIM pastes structured tags in a different way from other tags. When you paste a structured tag, the cell turns red in S7-PLCSIM. Click the cell, add a period to the end of the tag name, and a drop-down list displays all of the tag's subnodes. You can then select the subnode tags to paste and use in S7-PLCSIM.

Note

Cut and paste vs. copy and paste

When you perform a cut and paste operation between two open instances of S7-PLCSIM, the data from the source instance is copied instead of being cut.

In order to work around this behavior, delete the cut or copied rows from the source instance.

6.9.5.5 Sequence: import and export using Microsoft Excel

You can use Microsoft Excel .xlsx files to export from and import to a sequence by using the export and import buttons just as you would for a SIM table, but there are differences from the way export and import work between a SIM table and a sequence.

Editing an exported file

If you edit fields, including values, in an exported sequence file directly in Microsoft Excel, and then re-import that file into S7-PLCSIM, the results might be different than you expect.

You can address this issue in one of two ways:

- To prevent the issue, you can edit the exported Excel file by changing the format of the time and other numerical field(s) to be text fields, and then edit the Excel file.
- You can allow the import to proceed and then manually edit the incorrect values in the sequence editor.
Special considerations for using import and export with a sequence

You can import an .xlsx file into an empty sequence or into a sequence that already contains steps. Make sure that the imported file is not currently open in Excel or the import will fail.

The imported sequence step will be the same time that is present in the time field for the step.

The import operation does not overwrite the first or last step in a sequence because these steps are reserved.

You can export a sequence to populate another sequence in your current project or in another project.

If your .xlsx file contains one or more rows with empty address fields, the rows are imported into the sequence as empty steps.

Special case for import into an existing sequence

If the sequence already contains entries, the imported rows are added at the bottom of the existing entries and before the last step.

If you have defined a time for the last step in the sequence and the import results in exceeding that time, S7-PLCSIM automatically adjusts the stop time to accommodate the imported steps.

Importing watch table entries containing structured tags

S7-PLCSIM handles structured tags in a different way. When you import the contents of a watch table that contains structured tags, the cells containing the structured tags turn red in S7-PLCSIM. Click the cell, add a period to the end of the tag name, and a drop-down list displays all of the tag's subnodes. You can then select the subnode tags to use in the sequence.

6.9.5.6 Sequence: import from a STEP 7 trace

Overview of creating a sequence from a trace

S7-PLCSIM enables you to create a sequence based on a STEP 7 trace measurement file.

You can export a trace from STEP 7 in one of two file formats:

- tag trace recording file format (.ttrec or .ttrecx)
- Excel comma-separated value file format (.csv)

You can then import the exported file into S7-PLCSIM to create a sequence.
Exporting a trace from STEP 7

The file you import is a trace file that was exported from the TIA Portal in one of two formats:

- The TIA Portal trace may be exported as a tag trace recording (*.ttrec or *.ttrecx). This file contains not only the tag information and recorded data for a trace measurement, but also the configuration of the trace itself. Note that S7-PLCSIM ignores the configuration information.
- The TIA Portal trace measurement can also be exported to Microsoft Excel as a .csv (comma-separated value) file. This file contains only the recorded measurement data and the tag information.

Note

Both file types contain tag information for the trace measurement. S7-PLCSIM uses only the address information and not the tag information. The only way to update tag information is to perform a download from STEP 7.

Import a STEP 7 trace to create a sequence

There are two import types available to create a sequence from a STEP 7 trace file:

- import from an Excel file (*.xlsx or *.xls file format)
- import from a trace measurement (*.ttrecx, *.ttrec, or *.csv file format).

Therefore, make sure to select "Import sequence from trace measurement".

S7-PLCSIM uses the standard Windows file dialog for you to select the file for import.
Importing the trace file

You can import a STEP 7 trace to create a sequence from three different locations in the user interface:

- in the project tree, by right-clicking on the Sequences folder:

![Project Tree Screen Shot](image)

- from the sequence toolbar Import button dropdown:

![Sequence Toolbar Screen Shot](image)

- within the sequence grid by right-clicking to display the context menu:

![Sequence Grid Screen Shot](image)
Trace measurement addresses

A TIA Portal trace can be defined to record measurements for many addresses. You might not want to include all trace addresses in your sequence. For example, the trace measurement might include recordings for output addresses (%Q memory). These addresses are not valid for an S7-PLCSIM sequence.

When you have selected the file to import, S7-PLCSIM will inspect the trace measurement and build a list of the recorded addresses. You can then select which of the addresses should be used to generate a sequence. The screenshot below shows how this might be displayed:

Here are the features of the "Import trace measurement" dialog:

- All addresses from the trace measurement are listed in the dialog. A scroll bar is added if there are too many addresses to display on the dialog.

- Tag names are shown for addresses with available tag information. The tag names are taken from the current configuration downloaded to S7-PLCSIM - they do not come from the imported trace measurement. For addresses with no available tag name, the default "----" is displayed.

- By default, all addresses except output addresses are selected for inclusion in the import. Output addresses are enabled in the list, but are not selected by default.

Once you have selected the addresses to include and click "OK", a sequence is generated from the trace measurement.

Note

The trace measurement file contains tag information, but S7-PLCSIM uses only the address information and not the tag information.

The only way to update tag information in S7-PLCSIM is to perform a download from STEP 7.
Details about sequence generation

The sequence is generated according to the following rules:

- An "initialization step" is generated for each included address. This step is generated from the time of the first sample in the trace file, and sets the address to the value of the address in the first sample in the trace file. There is one initialization step for each included address. To visually distinguish these steps, a comment is generated for each one that says: "Initial step". Note that if you do not want to use initialization, you can edit, disable or delete the steps.

- A sequence step is generated for each change of value in one of the included addresses.

Note

Trace measurements are taken at each sample time. No sequence step is generated if the value of the address has not changed since the last sample time.

- The sample time for a trace can be much faster than the minimum increment time between sequence steps. S7-PLCSIM adds a sequence step for each sample in the trace file. If the time difference between two samples in the trace file violates the minimum sequence step increment time, the sequence step displays an error. You must correct all sequence step time errors before you can use the sequence.

- The trace supports triggering the recording based on a tag value. When you select this, the trace also supports recording values before triggering. This means the measurements during this pre-trigger time will have negative time values. The S7-PLCSIM sequence does not support negative times for steps. Therefore, when a measurement has negative times, the time values will be adjusted so that the first measurement time has a value of zero in the sequence. Subsequent step times are converted to positive values.

After the sequence is generated, it becomes an S7-PLCSIM sequence that can be edited and used as usual. There is no further connection to the original TIA Portal trace.
6.9.5.7  Recording a sequence from SIM table actions

Overview

You can create a sequence by recording actions you take in a SIM table. You can use this recording to generate a sequence based on the timing of the actions you record in the SIM table.

Recordable SIM table actions

The following example provides details about recordable SIM table actions, and how the generated sequence will appear when you stop recording.

Since the goal of recording SIM table actions is to create a sequence, the generated sequence will contain a step for every action you take that changes a value over time for each unique address. For example, any change to a value in the "Monitor/Modify value" column is recorded as a new step in the generated sequence at the relative time it occurred.

If you make multiple changes to a value over time, each of those changes becomes a step in the generated sequence.

You will obtain the same result by clicking bit checkboxes to change values in the "Bits" column, or by using the "Consistent modify" column to change a single value or multiple values.

You can also make recordable actions in the "Addresses" section of Device configuration. You can make immediate modifications to addresses belonging to your selected hardware module in this section. When recording is active, any actions you take in the Addresses section of Device configuration are recorded in the same way as if you performed those actions in the SIM table.

S7-PLCSIM rounds the times for sequence actions to the nearest 10 ms, in conformance with minimum sequence step time resolution specifications.

If two actions are less than 50 ms apart, this will lead to errors in the resulting sequence.
Recording your SIM table actions

The SIM table toolbar contains three buttons to support recording and playback:

- "Record" button
- "Stop recording" button
- "Pause recording" button

When you click the "Record" button, S7-PLCSIM begins to record specific actions you take in a SIM table to generate a sequence from those actions.

When you click the "Pause" button, S7-PLCSIM pauses the recording clock and stops recording actions. When you click the "Pause" button again, S7-PLCSIM continues recording.

When you click the "Stop" button, S7-PLCSIM generates a new sequence and adds it to your project with a standard system-assigned name, such as "Sequence_3". You can see this new sequence and the name it has been given in the project tree. You can rename the sequence by right-clicking the system-generated name and changing it to whatever you want. This new sequence is populated with all the actions you recorded from the SIM table.

Pausing the recording

Your current recording session is suspended when you click the "Pause recording" button on the SIM table toolbar. Clicking this button pauses the internal timer. Any actions you take while the sequence is paused will not be included in your recording.

Clicking the "Pause recording" button one more time will restart the recording process, and the internal timer resumes.

If you click the "Stop recording" button while the recording is paused, the recording session ends.

Ending the recording session

When you have recorded all the actions you want for your sequence, end the recording session by clicking the "Stop recording" button on the SIM table toolbar. A new sequence is generated from your recording, and will contain a step for each action that results from a value change for an address. S7-PLCSIM assigns a time for each step that is relative to the time the action was recorded. Sequences that are generated from a recording will always have a first step with the action set to "Start immediately".

Once the sequence has been generated and added to your project, it will function like any other sequence, and has no special behavior or limitations. You are free to modify or extend the sequence in any way you like.
6.9.6 Methods for starting a sequence

6.9.6.1 Sequence start action

The first row of the sequence defines the start condition for the sequence. There are two options: "Start immediately" and "Trigger condition". You select between these two options by choosing the appropriate action for the start step.

- "Start immediately". When you select this option, the first step of the sequence (the second row in the sequence editor) will immediately become active, and the execution time for the sequence will begin to count.
- "Trigger condition". For this option, you must define a trigger condition that will be evaluated to determine when the sequence executes. When you have defined a trigger for the sequence, and then select to play the sequence, the first step in the sequence will only become active when the trigger condition is satisfied.

Choose between these options by selecting the appropriate "action" for the start step, as shown below:

```
<table>
<thead>
<tr>
<th>Display format</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bool</td>
<td>Start immediately</td>
</tr>
<tr>
<td>Bool</td>
<td>Trigger condition</td>
</tr>
</tbody>
</table>
```

The default start action for a new sequence is "Start immediately". When this is the selected start action, there are no other fields to edit. The "Time" field will display 00:00:00.00 (or the equivalent time, based on your selected time format), and cannot be edited. There is no "Action parameter" available when you make this selection.

"Start immediately"

When you select this option, the first step of the sequence (the second row in the sequence editor) will immediately become active, and the execution time for the sequence will begin to count.

"Start immediately" is the default start action. When you select this start action, you do not need to edit any other fields. The "Time" field displays 00:00:00.00 (or the equivalent time, based on your selected time format). It cannot be edited. There is no "action parameter" when you make this selection.

"Trigger condition"

When you select this option, you must define a trigger condition that S7-PLCSIM will evaluate to determine when your sequence begins to execute. When you define a trigger condition and then select to play the sequence, the first sequence step becomes active only when the trigger condition is satisfied.

"Trigger condition" requires additional editing. You must define the start condition under the "Action parameter" column. When you select this option, the "Action parameter" field becomes a drop-down list which displays an editing control dialog box.

The trigger is defined as a specific condition for a single tag (or address). This behavior models the "Trigger condition" function for a STEP 7 trace.
6.9.6.2 Repeating a sequence from the toolbar button

The last step in a sequence is the "Stop sequence" step. The sequence stops executing at the time indicated in this step. Any active "Set to frequency" actions stop and the sequence returns to a stopped, editable state.

However, you might want to repeat the sequence in a looping manner. To cause the sequence to loop, click the "repeat sequence" toolbar button at any time, whether the sequence is stopped, paused, or playing. After you click this button, it appears to be visually pressed, which indicates that the sequence is actively repeating.

A sequence that is set to repeat has the following functionality:

- When the running sequence reaches the "Stop sequence" step, any active "Set to frequency" actions are stopped.
- For a sequence that is set to "Start immediately", the first step of the sequence immediately becomes active, and the sequence once again proceeds through the defined steps.
- The time that displays in the "Execution time" field is the time for the current iteration of the sequence, rather than the total cumulative time since the sequence first began executing. The current iteration for the repeating sequence (1…n) appears in parentheses next to the execution time.

You can stop a repeating sequence in the following ways:

- Click the stop button. The sequence stops immediately. Clicking the stop button does not affect the state of the "repeat sequence" button.
- De-select the "repeat sequence" button. This causes the sequence to stop when the time for the "stop sequence" step is reached.

Note that sequence repeat settings are not saved with the sequence in your S7-PLCSIM project.

6.9.6.3 Start a sequence with a trigger condition

This screenshot shows the default dialog box for the Action parameter field before you begin to configure the trigger:

To fully configure the trigger, you must input the following information:

- Input the tag or address to be used for the trigger
- Input the event that will be monitored for the tag
- Input the trigger value for the tag (if required)
To input the tag or address, you can click the “Trigger tag” control to see a list of all tags available in your current configuration:

![Trigger tag control]

You can select a tag from the list, or directly edit the field to input a tag. When you have selected a tag for the trigger, the tag name and associated address are displayed.

You can also enter an address into the "Trigger tag" field. If the address has an associated tag, the tag name is displayed in the Action parameter field after the entry is complete. If the address does not have an associated tag, only the address is displayed in the Action parameter field after the entry is complete.

Selecting the tag or address also determines what “events” are available. The screenshot below shows that an input bit address has been selected as the trigger tag. The event field displays the default value "= TRUE".

![Event field]

Different events are available for different data types. The table below lists the supported event types for different addresses:

<table>
<thead>
<tr>
<th>Address type</th>
<th>Data type</th>
<th>Supported events</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit address (%i0.0)</td>
<td>Bool</td>
<td>= TRUE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>= FALSE</td>
</tr>
<tr>
<td>Byte address (%mb0)</td>
<td>SInt / Byte</td>
<td>= value</td>
</tr>
<tr>
<td>Word address (%mw0)</td>
<td>Int / WORD</td>
<td>&lt;&gt; value</td>
</tr>
<tr>
<td>DWord address (%md0)</td>
<td>Dint / DWORD</td>
<td></td>
</tr>
<tr>
<td>DWord address (%md0)</td>
<td>Real</td>
<td>&gt; value</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt; value</td>
</tr>
</tbody>
</table>

For tag types that support a comparison value, the "Value" field in the dialog box becomes enabled.
In the example below, the user has selected a WORD address. The "Value" field is enabled and the user must enter a comparison value.

The error indication is removed when the user enters a value.

And when the user closes the control by clicking the green check box button, the trigger condition displays in the "Action parameter" field.

The blue "X" button is a cancel button. When you click this button, none of your changes are saved.

When you save the sequence, the trigger condition is also saved. When you reopen the project, the trigger condition is just as it was when you saved the project.

When you export a sequence, the trigger condition is exported along with the sequence. The trigger condition remains active if you re-import a sequence that contains a trigger condition.

6.9.6.4 Repeating a sequence configured to trigger from a tag

When you have selected "Repeat sequence" for a sequence that is set to "Trigger condition", the starting condition is evaluated again each time the sequence repeats.

- If the starting condition is satisfied, then the first step of the sequence immediately becomes active, and the sequence proceeds through the defined steps.
- If the starting condition is not satisfied, the sequence pauses until the start condition is satisfied and then proceeds as usual.
6.9.6.5 Visual feedback while running a sequence

Visual feedback in Project view while playing a sequence

S7-PLCSIM provides the following visual feedback while a sequence is actively running:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Running Icon" /></td>
<td>In the project tree, a &quot;running&quot; icon displays next to the sequence that is currently running. If the sequence is paused, a &quot;pause&quot; icon appears in place of the &quot;running&quot; icon. In this way, you can select the correct sequence that you want to stop.</td>
</tr>
<tr>
<td><img src="image" alt="Sequence Playing Icon" /></td>
<td>The &quot;sequence playing&quot; icon appears in the lower right side of the Sequence editor window while the sequence is running.</td>
</tr>
<tr>
<td><img src="image" alt="Step Execution Icon" /></td>
<td>The &quot;step execution&quot; icon moves from step to step in the sequence, indicating which step is executing. If you defined multiple steps to begin at the same time, all of the steps display the green arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Execution Time Icon" /></td>
<td>The execution time is displayed in the Sequence editor toolbar.</td>
</tr>
</tbody>
</table>

Visual feedback after stopping a sequence

You can tell when a sequence has stopped running from the following visual indicators:

- There is no "running" icon next to the sequence name in the Project tree.
- The "sequence playing" icon no longer appears in the lower right corner of the Sequence editor window.
- The "step execution" icon stops on the last step executed.
- The execution time stops and displays the total sequence run time. If the sequence is a repeat sequence, the number of repetitions displays in parentheses.

6.9.7 Sequence actions and action parameters

Each entry, or step, in a sequence represents an action to take on the specified address at the time specified in the "Time" column. The type of action that can be specified depends on the data type of the address.

You can specify an address by tag name in the "Name" field or by address in the "Address" field. A sequence entry's address determines its data type and available actions.
Sequence example using bit address

The following example describes how the address for the step determines available options for a bit address:

- Enter an input bit address either by address or by tag name.
- S7-PLCSIM populates the remaining fields in the sequence row with default values.
- The "Set to value" action is the default action. You have two possible options for the action parameter: FALSE or TRUE.
- If you want the "Set to frequency" action rather than the "Set to value" action, select it using the drop-down list and enter a frequency in Hertz in the "Action parameters" field. The input will pulse at that frequency when you run the sequence.

Sequence action: "Set to value"

"Set to value" is a discrete action. In other words, the value is written only one time to the peripheral input. However, since there is no physical I/O to overwrite this action, the specified input holds its value until another action changes it.

Sequence action: "Set to frequency"

The "Set to frequency" action is only available for input bit memory. For all other address areas, and for all other input address sizes (Byte, Word, DWord), the only available action is "Set to value".

When the action is "Set to frequency", the data writes that generate the pulse continue until you change the action for that address or until the sequence stops. If you have selected "Repeat sequence" for the last step, the data writes continue until you select "Stop sequence".
6.9.8 Time-related Sequence information

6.9.8.1 Sequence time entry

Your sequence entries sort and run based on the contents of the "Time" field. The time displays in the format: hours:minutes:seconds.fractional seconds (00:00:00.00).

If you select the "Time" field and simply enter a number (such as "12", for example), S7-PLCSIM interprets and displays the number as 12 seconds (00:00:12.00). To get hours, minutes, and fractional seconds, you must explicitly enter the time using the proper format.

The maximum time allowed for an entry is 23:59:59.95 (S7-PLCSIM rounds sequence time entries to the nearest 50 milliseconds).

The following table shows examples for time values in your sequence:

<table>
<thead>
<tr>
<th>Value entered</th>
<th>Resulting time value</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>00:00:12.00</td>
</tr>
<tr>
<td>12.2</td>
<td>00:00:12.20</td>
</tr>
<tr>
<td>.02</td>
<td>00:00:00.02</td>
</tr>
<tr>
<td>2:2</td>
<td>00:02:02.00</td>
</tr>
<tr>
<td>12:12.12</td>
<td>00:12:12.12</td>
</tr>
<tr>
<td>Empty</td>
<td>00:00:00.00</td>
</tr>
</tbody>
</table>

Any illegal entry, such as text "abcd" turns pink, an error icon displays, and the text that caused the error displays.

Order of sequence steps

You do not need to add steps to the sequence in the order they should be executed. You can enter the steps in any order, and they run based on the times you enter in the "Time" column.

You can sort your steps by time before running the sequence by selecting the "Time" column header.
Sequence time entry rules

You can define multiple entries with the same time as long as they are not for the same address. An error occurs if you define multiple actions for the same address with the same time.

Note

Multiple steps with the same time

If you define multiple actions with the same time for different addresses, no error displays, but there is no way to know which action will execute first until you play the sequence. This could result in different ending values for your addresses.

You can sort on the "Address" column to see the actions based on which input addresses are affected.

Sequence end times for Stop and Repeat sequences

The time for the last step of your sequence must be equal to or greater than the time for the last step of your sequence plus 50 ms for both Stop and Repeat sequences.

Sequence time entry examples

If you want an input point to pulse at a certain frequency for five seconds and then want the input cleared, the following two sequence examples could be used to accomplish this.

Example: Ending a set to frequency action after five seconds

For the first step, choose "Set to frequency" as the action and enter the frequency in Hertz in the "Action Parameters" field.

For the second step, enter a time of 00:00:05.00 in the "Time" field, choose "Set to value" as the action, and enter the value "0" in the "Action Parameters" field.

The pulse generation stops after five seconds.

Example: Ending a sequence after five seconds

You can also enter 00:00:05.00 in the Time field for the last step in the Sequence. This also stops the pulse generation after five seconds if you have selected "Stop sequence" in the last step.
6.9.8.2 Sequence step timing

S7-PLCSIM supports timing of sequence steps in two ways:

- You can specify that actions occur at the same time
- You can specify that steps execute sequentially

You can create multiple steps to set the values for several addresses at the same time. This is not an error condition. However, if you create multiple steps to set the value for the same address at the same time, this is an error condition. S7-PLCSIM indicates the error condition by changing the color of the error fields to red.

If the sequence steps contain different times, S7-PLCSIM will still enforce a minimum time of 50 ms between steps. If you enter a time that is less than 50 ms after the time in the previous step, this is an error condition and is indicated as such in the user interface.

To illustrate these rules, consider the following examples:

- Three steps with different addresses are defined to execute at the same time. Since each step acts on a different address, this is not an error.
- Multiple steps are defined to execute at the same time for the same address. This is an address conflict error condition.
- When you manually enter the time for a step, S7-PLCSIM rounds the step time to the nearest 10 ms boundary. You are not prevented from entering a time that is < 50 ms from the previous step in the sequence. For example, if you manually enter a time of, for example, 63 ms in the Time field for a step, S7-PLCSIM rounds 63 ms to 60 ms. This scenario does not create errors. But if you now enter a time of 91 ms for another step and commit the edit, the 91 ms time rounds to the nearest 10 ms (in this case, 90 ms). Since this step is not at least 50 ms higher than the 60 ms step, this causes an error condition for the 90 ms step.
- When you edit step times, the "Stop sequence" step will automatically update to equal the time for the latest step plus 50 ms.
6.9 Working in the Sequence editor

6.9.8.3 Edit execution time

When you pause a sequence, the current execution time field becomes enabled so that you can edit the execution time. Editing the current execution time gives you a way to restart the sequence at a different location, either rewinding to a prior step or skipping ahead to a later step.

Here is an example:

Here, the sequence has been paused at a time of 12.82 seconds. No new steps become active while the sequence is paused.

Now, assume you edit the execution time to be 21.5 seconds and then click "Start sequence":

Sequence operation starts at the step corresponding to the new execution time. In this example, the sequence skips the step defined at time 21.0 seconds, and begins operation at the step defined for time 21.50 seconds.

If you edit the execution time so that it is between two steps, clicking Start sequence causes the sequence timer to start and the next step becomes active when its time is reached.

Note that the step that was active when you paused your sequence is a "set to frequency" action. Since this step was active when you paused the sequence and then moved the execution time forward, this step is still active when the sequence is started again.

Here is exactly what happened in the above example:

- When the sequence was paused, the active step was running a "set to frequency" action for %I0.3.
- While the sequence was paused, the execution time was edited to skip the next step in the sequence. This step would have stopped the "set to frequency" action.
- By skipping this step, the set to frequency action for %I0.3 is allowed to remain active.
You can also edit the execution time to replay a portion of the sequence. Here is our original example of a paused sequence:

Now, assume you edit the execution time to be 0.00, click Start sequence and then click Pause sequence at 1.00 second:

The active step has a time of 00.00 seconds, but the action at this step is not taken since the execution time was modified to 1.00. Also notice that the step that was active when you paused the sequence at 12.8 seconds (set to frequency for %I0.3) is no longer active. Since you have set the time to an earlier time, this set to frequency action does not restart when you click Start sequence again.

- If you set the execution time to 00.00 seconds, you will restart the sequence. In the example above, the sequence is configured to start by reaching a condition. Setting the time back to 0.00 seconds causes the starting condition to be evaluated again. Editing the execution time to 00.00 seconds is equivalent to stopping and restarting the sequence.

- You cannot set the time past the time of the last step. If you attempt to do so, S7-PLCSIM will autocorrect the time to the stop/repeat sequence step time. If you choose to repeat the sequence, this has the same effect as restarting the sequence, beginning from the first step.

- When you save your project, the current execution time is not saved along with the project. If you save and close the project, any sequences that were in a paused state are shown as stopped.
6.9.9 Inserting, adding, and deleting sequence steps

When you open a new sequence, it contains three rows, or steps:

- A first step containing the "first step" icon in the indicator column, "00:00:00.00" in the "Time" column, and "Start immediately" in the "Action" column. You cannot edit this step.
- An empty step with "00:00.00.00" in the "Time" column.
- A final step containing the "last step" icon in the indicator column, "00:00.00:05" in the "Time" column, and "Stop sequence" (the default value) in the "Action" column.

You can create the first step in a new sequence by editing the empty row.

Inserting a step

When you insert a step, the new step appears above your currently selected step.

You can insert a step in one of the following ways:

- Click the "Insert step" button on the Sequence editor toolbar
- Right-click anywhere in a step and select "Insert step" from the shortcut menu

Adding a step

When you add a step, the new step appears below your currently selected step. The time for the added step will equal the time for the currently selected step plus the default interval time.

You can add a step in one of the following ways:

- Click the "Add step" button on the Sequence editor toolbar
- Right-click anywhere in a step and select "Add step" from the shortcut menu

Using the default interval

If you want to change the default time for an added step, enter a different value in the "Default interval" text box on the Sequence editor toolbar. The time for the new step will be the time for the selected step plus the default interval time value.

For example, if the time for the current step is "00:00:05.00" and you enter "2000" for the default step interval, your added step will have the time "00:00:07.00".
When you add a new step, the default interval time is added to the time of the selected step and all subsequent added steps.

**Note**

**Effect of the default interval on inserted steps**

The default step interval is only used for added steps. If you insert a step, the time for the inserted step is the time for the currently selected step minus the default interval time value.

The valid range for the default interval is 50 to 5000 ms. Your entry is rounded to the nearest 10 ms.

For example, if you enter "1445" the default interval rounds to "1450".

These are examples of invalid entries that will cause the default interval to revert to its previous value, or to "50" if there is no existing default interval:

- "9999"
- "b"
- ". 100"

**Deleting a step**

To delete a step, select the step you want to delete and perform one of the following actions:

- Click the "Delete" key on your keyboard
- Click the "Delete" toolbar button
- Right-click and select "Delete" from the shortcut menu
6.9.10 **Enable and disable sequence steps**  

You can temporarily disable one or more steps in a sequence. Disabled steps are ignored when you play a sequence. This functionality provides you with flexible way to debug your sequence. You can re-enable the disabled step(s) with a single click so that the steps are included the next time you play the sequence.

To disable a step, perform the following actions:

1. select the step by either selecting the entire row, or clicking a cell in the row
2. click the "disable step" button on the Sequence editor toolbar.

You can disable multiple steps at the same time by selecting the steps and then clicking the "Disable step" button.

You can re-enable a step by selecting the step and then clicking the "enable step" button.

**Rules regarding disabling and enabling steps**

You can disable a step even if it contains an error. In this case the error icon for the row will be replaced by the disabled icon. This allows you to play the sequence and ignore the error.

You can freely edit a disabled step. If you edit the step so that it becomes invalid, the step will not be marked with an error until it is re-enabled. This condition does not prevent you from running the sequence.

You cannot disable either the "Start sequence" step or the "Stop sequence" step. If you select either of these steps and then click the "Disable step" button, no error is displayed and the step will not be disabled.

The enabled or disabled state of a step is preserved when you copy and paste it.

The enabled or disabled state of a step is preserved when you export a sequence. When you import the sequence again, any disabled steps will be imported in the disabled state.

Sorting the table by time or address will also sort disabled steps.

When you disable a step, this might change the status of another step in the sequence. For example, you might receive an error if there are actions on the same address at the same time. You can remove this type of error from both steps by selecting and disabling one of the steps.
6.9.11 Step time adjustment

When editing and debugging a sequence, you might find that you need to insert a step in the middle of a sequence. As a part of this operation, you might want to delay all the following steps by some amount of time.

To accomplish this, follow this example:

- After testing your sequence, you determine that you need a new step between the existing steps at 02.00 seconds and 02.50 seconds. First use the "Insert step" button to create an empty step at the correct position, then edit the step.

- You want to add a 0.50 second delay to all of the following steps in the sequence. You can do this by manually editing the time for each step, or you can select the steps, right-click and select "Step time adjustment".

- This action allows you to add a positive or negative time to all the selected steps. Selecting this context menu option will display a small dialog box where you can enter an amount of time to add to each step.
  - Adding a positive time increases the "Time" value for each of the steps by that amount.
  - Adding a negative time decreases the "Time" value for each of the steps by that amount. If the decrease would cause any times to become negative, then these step(s) are set to a time of 00.00.

The step time adjustment action does not apply to the start step of the sequence. This step always begins at time zero. If the start step is included with a multiple row selection, there is no change to the start step.

The step time adjustment action does apply to the "stop sequence step". You can edit the time for this step either individually or together with other steps.

The minimum delay (either positive or negative) is 10 ms.

"Step time adjustment" is an action you can undo.

A dialog box with a text entry field is used to indicate the delay time.

6.9.12 Running more than one sequence at a time

You can have multiple sequences in a single project, but you can only run one sequence at a time. When a sequence is running, the "Start sequence" button is not active for any other sequence.
## 6.9.13 Sequence error conditions

When an error condition exists for a sequence entry, the cell containing the error turns pink and a red "X" icon appears in the indicator column. You can hover over the erroneous entry to display an associated error message.

You cannot play a sequence as long as error conditions exist in the sequence.

The possible errors for a sequence are as follows:

<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undefined tag name</td>
<td>Tag name entered has no match in the download from STEP 7</td>
</tr>
<tr>
<td>Invalid address</td>
<td>Address is syntactically incorrect</td>
</tr>
<tr>
<td>Invalid time</td>
<td>Time is syntactically incorrect</td>
</tr>
<tr>
<td>Invalid Action parameter</td>
<td>Action parameter is syntactically incorrect, or is out of range for the address</td>
</tr>
<tr>
<td>Action parameter out of range for &quot;Set to frequency&quot; value</td>
<td>The valid range is 1 to 100 Hz</td>
</tr>
<tr>
<td>Duplicate steps</td>
<td>Two steps are attempting to act on the same address at the same time</td>
</tr>
<tr>
<td>Steps too close together</td>
<td>S7-PLCSIM enforces a minimum 50 ms time difference between any two steps</td>
</tr>
<tr>
<td>Not online</td>
<td>STEP 7 is not online when attempting to run a sequence</td>
</tr>
<tr>
<td>Import only partially successful</td>
<td>One or more missing addresses in a Microsoft Excel file</td>
</tr>
</tbody>
</table>

Note that the Sequence editor does not perform a range check on addresses. It attempts to modify any address that is syntactically correct.
Simulating motion control

7.1 Motion control overview

S7-PLCSIM supports downloading STEP 7 projects that contain motion control elements for S7-1500 and ET 200SP CPUs.

Note

S7-1200 motion control projects

S7-PLCSIM does not support motion control for S7-1200 CPUs.

Technology modules and simulation

S7-PLCSIM simulates a real CPU, but not configured, connected technology modules or other IO devices.

It is possible to download a project with technology modules for operation of motion control. However, the built-in logic of the technology modules is not part of the simulation. Therefore, S7-PLCSIM cannot simulate the associated motion control instructions.

Motion control simulation limitations

In general, your simulation results might be limited if any of the following are true:

- Your project uses very short cycle times
- Your project has a hardware configuration with a large number of devices
- Your project uses a large number of technology objects

The behavior of your simulation also depends on the type of technology object(s) you use.
7.2 Restrictions with motion control

7.2.1 Simulations and homing mode
With a real CPU, homing is set directly and the state "reference" correspondingly to it. The hardware inputs are not evaluated in simulation.

7.2.2 Technology objects not loaded
If your motion project contains a large number of technology objects, your motion program might not download to S7-PLCSIM.

7.2.3 Maximum of 5,120 motion control resources
There are motion control resources on each CPU that can be distributed to the technology objects. S7-PLCSIM supports a maximum of 5,120 motion control resources.

Exceeding the quantity structure
When you load a project into a CPU, STEP 7 checks whether the quantity structure for a configured CPU is correct. An alert message displays if the quantity structure is exceeded.

A project that uses more than 5,120 motion control resources can be downloaded to a virtual controller. However, there is no message indicating that the quantity structure has been exceeded.

After your program accesses the technology objects, you can observe the following indications if the quantity structure has been exceeded:

- an error message at the block
- a value of zero for the object

7.2.4 Wait briefly after going to RUN mode to access motion control technology objects
The simulated PLC processes motion control commands more slowly than a physical PLC. Because of this difference in processing time, you might encounter an "error" or "busy" state if you attempt to access motion control objects too quickly after going to RUN mode. This is because the objects might not have finished processing completely.

To avoid the situation, wait briefly to access motion control objects after you put the PLC in RUN mode.

For further details about motion control, see the help section "Differences common to all supported PLCs" > "Simulating motion control".
7.2.5 **Motion OB overruns**

An overload occurs when events which originate from the same source occur faster than they can be processed. S7-PLCSIM does not process motion OB overruns.

7.2.6 **Upgraded projects containing blocks OB91 and OB92**

You cannot load a motion control project that contains the blocks OB91 (MC-Servo) and OB92 (MC-Interpolator) to S7-PLCSIM V15.

To enable simulation, delete the blocks OB91 and OB92 and then recompile your project. When you recompile, the properties of blocks OB91 and OB92 reset to the default values. You will then be able to load your motion control project to S7-PLCSIM.

7.2.7 **Simulation deactivates MC-PreServo and MC-PostServo**

S7-PLCSIM does not simulate the operations of the motion OBs MC-PreServo and MC-PostServo.

7.2.8 **TO_PositioningAxis**

With the TO_PositioningAxis technology object, the simulated drive provides feedback regarding position functions to S7-PLCSIM.

**Axis position feedback**

The setpoint (position) is integrated with a certain time delay (PT1 element). The result of this calculation is fed back to the TO_PositioningAxis object as the actual position of the axis.

**Homing axis**

If you have selected the homing mode "Use zero mark via PROFIdrive telegram" in STEP 7, S7-PLCSIM responds immediately to every active (Mode 2, 3, 8) or passive (Mode 4, 5) homing command (MC_Home) with the actual position being set as the home position.

**Simulation restrictions**

- S7-PLCSIM does not simulate an analog positioning axis.
- With Dynamic Servo Control (DSC) telegram 5, you might need to adjust the STEP 7 settings under "Control loop: Precontrol and velocity gain (Kv factor)" and/or under "Positioning monitoring > Following error" to obtain meaningful simulation behavior. Adjust these settings incrementally until your simulation responds as expected.
7.2 Restrictions with motion control

7.2.9 **TO_ExternalEncoder**

With the TO_ExternalEncoder technology object, the simulated external encoder provides static/fixed position feedback, which is set by homing commands, to S7-PLCSIM.

**Homing**

Active homing is not possible with the TO_ExternalEncoder object.

If you have selected the passive homing mode "Use zero mark via PROFIdrive telegram" in STEP 7, S7-PLCSIM responds immediately to every passive (Mode 4, 5) homing command (MC_Home) with the actual position being set as the home position.

7.2.10 **High Speed Counter**

S7-PLCSIM does not support simulation for the High_Speed_Counter technology object for S7-1500 compact CPUs.

7.2.11 **High Speed Counter functionality for S7-1500C (compact) PLCs**

S7-PLCSIM supports simulation for the S7-1500 compact controllers (S7-15xxC).

However, it is not possible to simulate the onboard high speed counters (HSC) or pulse generators (PTO/PWM). Programs that rely on this functionality might not behave realistically during simulation.

7.2.12 **Isochronous mode not possible error**

Under some motion control scenarios, you might receive an error message that isochronous mode is not possible.

**Example scenario**

The TO OutputCam is configured with TM Timer DIDQ in a distributed ET 200SP high feature interface module.

**Observation**

When TO is activated with MC-OutputCamEnable, Alarm Number 113 displays a message that isochronous mode is not possible.

**Solution**

- The configured output for the cam or cam track technology object or the input for the technology object measuring input cannot be used in isochronous mode. Configure the IO in the device configuration as isochronous IO.
- Make sure that the organization block MC_Servo [OB91] is called synchronously with the bus system.
Simulating communication

8.1 Overview of simulating communication

S7-PLCSIM V15 supports communication between simulation instances. An instance can be an S7-PLCSIM V15 simulation, a WinCC runtime simulation, or an S7-PLCSIM V5.4.8 simulation.

You can run two instances of S7-PLCSIM V15, up to eight instances of S7-PLCSIM V5.4.8, and an even larger number of WinCC runtime simulations, and they can communicate with each other.

All simulation instances must run on the same PC in order to communicate with each other.

Supported connections

S7-PLCSIM V15 supports TCP/IP and PROFINET connections.

If you want to simulate communication using a TCP connection, you must use a TCON instruction to set up and establish the communication connection. S7-PLCSIM does not recognize a TCP connection that is established in the TIA Portal "Devices & networks" section.

IP addresses and communication

You cannot run multiple simulations if the simulated PLCs have the same IP address. Each simulated PLC must have a unique IP address.

T-Block instructions and data buffering

S7-PLCSIM V15 implements T-Block instructions without data buffering on the receiving CPU.

The simulated sending CPU's TSEND instruction does not complete until the program on the simulated receiving CPU executes the TRCV instruction.

T-block instructions and 1024 byte limitation

There is a maximum of 1024 bytes of data that can be received at a time.
8.2 Running multiple concurrent simulations

S7-PLCSIM V15 supports two concurrent simulations for any combination of supported CPU types. The simulations must have unique IP addresses for proper communication and functionality. However, you are not restricted from starting a second simulation that has a conflicting IP address with an already-running instance, so you should avoid this.

You can also run an S7-PLCSIM V15 simulation simultaneously with an S7-PLCSIM V5.x simulation.

You can create or open any number of S7-PLCSIM projects with two simulations already running as long as the projects do not have running simulations. When two concurrent simulations are active and you try to start a third, you will receive an error message that the maximum number of instances has been reached.

8.3 Supported communication instructions between PLC families

The following tables summarize the valid PLC-to-PLC connections by communication instruction and PLC pair:

### GET / PUT

<table>
<thead>
<tr>
<th>CPU #1</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-400</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1200</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1500</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### BSEND / BRCV

<table>
<thead>
<tr>
<th>CPU #1</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-400</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### USEND / URCV

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-400</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### TSEND / TRCV

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200 (SFB 100, 101)</th>
<th>S7-1200 (SFB 150, 151)</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200 (SFB 100, 101)</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1200 (SFB 150, 151)</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### TUSEND / TURCV

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200 (SFB 100, 101)</th>
<th>S7-1200 (SFB 150, 151)</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200 (SFB 100, 101)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200 (SFB 150, 151)</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
### TSEND_C / TRCV_C

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### TUSEND_C / TURCV_C

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

### MODBUS TCP

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

### TMAIL

<table>
<thead>
<tr>
<th>CPU #2</th>
<th>S7-300</th>
<th>S7-400</th>
<th>S7-1200</th>
<th>S7-1500</th>
<th>ET 200SP</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>CPU #2</td>
<td>S7-300</td>
<td>S7-400</td>
<td>S7-1200</td>
<td>S7-1500</td>
<td>ET 200SP</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>--------</td>
<td>---------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>S7-300</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-400</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1200</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>S7-1500</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>ET 200SP</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Simulating communication

8.3 Supported communication instructions between PLC families
Error conditions and limitations

9.1 Overview
Specific actions or events might result in errors or unexpected behavior in S7-PLCSIM V15 or in STEP 7. A description of each known issue and any workarounds follows.

9.2 Specific error conditions and limitations

9.2.1 Yellow coloring for Fail-Safe IO
It is possible that S7-PLCSIM might not display IO addresses for Fail-Safe devices with yellow coloring. Be aware that this might happen when you simulate Fail-Safe applications.

9.2.2 Scan cycle overflow
It is possible to overflow the S7-PLCSIM cyclic event queue when your simulation contains cyclic interrupts. Due to the speed of S7-PLCSIM in relation to the speed of actual hardware, your simulation might not be able to process cyclic OBs within the cycle time you specified. S7-PLCSIM provides visual notification of an overflow by means of diagnostic buffer messages and a red error icon in the project tree.

If the main scan cycle overflows, go to "Options > Settings > Cycle time monitoring". You can then take one of two actions:

- Select the check box for "Disable scan cycle monitoring".
- Select the check box for "Specify maximum cycle time" and then input a larger value in the "Maximum cycle time" box. You can enter a time up to 60000 ms.

If a cyclic interrupt OB overflows, increase the cyclic time for the OB in STEP 7.

After taking any of these actions, you must perform another download from STEP 7 for the change to take effect.

9.2.3 Incompatible diagnostic status for simulated S7-1500 PLCs with firmware version 1.8
When you simulate an S7-1500 PLC with firmware version 1.8, S7-PLCSIM might display the diagnostic status "Incompatible". You can ignore this status message because your simulation will function normally.
9.2.4 Simulating HMI connections

When you simulate HMI connections, the simulated HMI firmware version must be 14.0.0.0 or higher.

9.2.5 HMI Accessible tags

In STEP 7, tags are checked as "Accessible from HMI" by default. In the following example, the HMI accessibility for the tags "Static_3" and "Static_4" has been unchecked:

After you perform a download from STEP 7 to S7-PLCSIM, you will note that the tags "Static_3" and "Static_4" are not available in S7-PLCSIM:

If you want to work with these tags in S7-PLCSIM, simply check the box for the tags in STEP 7 and perform another download to S7-PLCSIM.
9.2.6 Compile error after attempting to download to S7-PLCSIM

When you attempt to download a STEP 7 program to S7-PLCSIM, you might receive an error that the user program was not compiled and that you should compile the program again.

You might encounter this scenario:
- when you simulate a program that was uploaded from a physical PLC
- when you simulate a program that was copied and pasted into your project

This error is related to automatically generated program blocks such as MC-Servo and MC-Interpolator OBs in motion control programs.

To resolve the error, delete the automatically generated blocks and then compile the program again by using the command "Compile > Software (rebuild all blocks)". This command will correctly recreate and compile the blocks for use in S7-PLCSIM. However, before deleting the blocks, check the settings in your OBs.

Be aware that this error is not limited to motion control. Any program that contains automatically generated blocks might experience the issue. After you remove the automatically generated blocks, your program should compile and download to S7-PLCSIM without further error.

9.2.7 "Cut" performs a "Copy" between S7-PLCSIM instances

When you perform a cut and paste operation between two open instances of S7-PLCSIM, the data from the source instance is copied instead of being cut.

Description of behavior

Start two instances of S7-PLCSIM and create a simulation project in both instances.
Enter addresses into a SIM table or sequence in one of the instances.
Cut one, or several, of the rows from one instance and paste them into a SIM table or sequence in the other instance.
Observe that the cut items from the source instance are copied instead of being cut, or removed. The cut items appear in the target instance as expected, but remain in the source instance.

Solution

In order to work around this behavior, delete the cut rows from the source instance after you have pasted them into the target instance.
9.2 Specific error conditions and limitations

9.2.8 Simulating communication with an HMI and multiple PLCs

If you want to simulate multiple PLCs with an HMI, you might encounter unexpected connection behavior due to the way S7-PLCSIM simulates communication.

You can prevent the problem by starting all PLC simulations before launching your HMI.

---

**Note**

If you have started your HMI before starting all PLC simulations and then notice unexpected behavior, close and restart the HMI while the PLC simulations remain active.

9.2.9 Avoid forcing inputs when simulating S7-1500

Forcing inputs with a simulated S7-1500 or ET 200SP CPU can cause undesired behavior. Instead, use an S7-PLCSIM SIM table to modify input values for these PLCs.

9.2.10 Simulating Fail-Safe programs

It is possible that your Fail-Safe program might go to STOP unexpectedly. This can occur because of the difference in cycle times between the simulated PLC and a physical PLC.

To correct the situation, increase the F parameter value in STEP 7 by following these steps:

1. In the inspector window, go to "General > Fail Safe > F parameter" and set the "Default F monitoring time for central F I/O" to its maximum allowable time (65535 ms).
2. Perform another download from STEP 7 and then run your simulation again.

9.2.11 Use STEP 7 safety system library v1.3 or later for Fail-Safe IO

In order to successfully simulate and debug a project that contains Fail-Safe IO, your project must use safety system library V1.3 or later. If your project uses an older version of this system library, your Fail-Safe IO simulation will not function correctly.

9.2.12 Working with global libraries

If your project uses a library, you must compile both hardware and software before performing a download to S7-PLCSIM. If you perform only a partial compile, your download will fail.
9.2.13 **Valid range for Sequence "Set to frequency" values**

By default, S7-PLCSIM V15 supports a "Set to frequency" value for an input bit of 1 to 100 Hz in the Sequence editor "Action" column.

If S7-PLCSIM is not producing a reliable frequency input, run your sequence again after changing the "Set to frequency" value to 16 Hz or lower.

9.2.14 **Incorrect RET_VAL parameter values for S7-1500 EN_AIRT and DIS_AIRT instructions that are called from multiple OBs**

The extended interrupt instructions EN_AIRT and DIS_AIRT function correctly for S7-1500 projects if they are called from the same OB.

These instructions do not function correctly if they are called from more than one OB. If they are called from more than one OB, the RET_VAL parameter value might not be correct.

9.2.15 **Cyclic event overflow error**

It is possible to overflow the S7-PLCSIM cyclic event queue when your simulation contains cyclic interrupts. Due to the speed of S7-PLCSIM in relation to actual hardware, it might take longer to create the diagnostic buffer entry than the time until the next cyclic interrupt event.

If this occurs, an additional entry is placed in the queue, which then causes another overflow. S7-PLCSIM provides visual notification of an overflow by means of diagnostic buffer messages and a red error icon in the project tree.

If the queue overflows, go to "Options > Settings > Cycle time monitoring". You can then take one of two actions:

- Select the check box for "Disable scan cycle monitoring".
- Select the check box for "Specify maximum cycle time" and then input a larger value in the "Maximum cycle time" box. You can enter a time up to 60000 ms.

After taking one of these two actions, you must perform another download from STEP 7 for the change to take effect.

9.2.16 **HMI password protection levels and simulation**

You cannot configure a PLC protection password in your HMI and then download to S7-PLCSIM.

If you attempt to run a simulation with protection levels set, the HMI receives an error and is unable to connect to S7-PLCSIM. S7-PLCSIM does not check protection levels and therefore indicates that no password is set.

If you have already set protection levels for your PLC, you must remove them before running a simulation. After you are finished with your simulation, you can restore your protection levels.
9.2.17 **STEP 7 online & diagnostics functions**

Certain online & diagnostics functions do not serve a useful purpose for simulation. Using them might cause unexpected behavior in S7-PLCSIM. These include:

- Assign IP address
- Format memory card
- Assign name
- Firmware update

9.2.18 **Simulation during standby mode**

Simulation might stop when your computer or programming device enters "standby" or "sleep" mode. If this happens, communication between STEP 7 and S7-PLCSIM is suspended.

When your computer or programming device becomes active again, it might be necessary to reestablish communication, or in some cases, to reopen your simulation project.

To prevent this situation, disable standby mode for your computer or programming device.

9.2.19 **Running S7-PLCSIM on a remote desktop connection**

It is possible to run S7-PLCSIM by using a remote desktop connection. However, you should avoid disconnecting the connection to the desktop client during configuration. In rare cases, this can lead to the software user interface being blocked.

If you experience user interface blockage, follow these steps on the desktop client:

1. Open the Windows Task Manager and close the "rdpclip.exe" process.
2. Type in "rdpclip.exe" in the command prompt to restart the process.

Note that you will lose the current contents of the clipboard. However, you can then continue configuration as usual.

You should restart S7-PLCSIM as soon as possible.
9.2.20 Working with automatically synchronized network drives

If you store a project that is automatically synchronized on a network drive or in a cloud directory (with Dropbox, Syncplicity or Google Drive, for example), this can lead to data loss if the synchronization takes place only partially or asynchronously. Therefore, storing and editing projects directly on synchronized network drives or cloud directories is not recommended.

If you must use synchronization, make sure that it is implemented in such a way that the current (local) project data replaces the project data on the network drive or in the cloud directory.

Always close your projects before synchronization, and then make sure that all project directory files are synchronized together and completely.

9.2.21 Project menu delay

You might experience delays, and possibly a crash, when you are opening the project menu if a project in the most recently used projects list is located on a network drive that is not connected.

To correct the problem, reconnect the network drive, or move your projects folder to a connected drive.

9.2.22 Mnemonics selection

Entering values with commas as decimal places (for example, “1,23”) might lead to an error with some Windows language settings.

Use the international format with a period as the decimal place (for example, “1.23”).
Error conditions and limitations

9.2 Specific error conditions and limitations
Index

A
Access protection, 23
Adding, editing, deleting rows, 89
Address section
undo/redo, 86
Addresses section, 86
Application settings, 54, 63
reset, 63
undo, redo, 64
Applying tags for addresses, 89
Automatic tooltip cascades, 54
Avoiding STOP mode in Fail-Safe simulations, 152

B
Breakpoints, 112

C
Changing the CPU family, 19
Clearing undo and redo, 69
Clipboard actions
selecting multiple rows, 88
Common clipboard actions, 88
Common row indicators, 91
Communication
and two-instance limit, 144
Communication instruction support
ET 200SP and ET 200SPF, 30
S7-1200, 25
S7-1500, 28
Communication Instructions
valid PLC to PLC connections, 144
Communications
data buffering, 143
Compact view, 56
CPU name, 46
CPU operator panel, 47
MRES button, 47
overview, 45
title bar, 46
Concurrent simulations, 144
Configuration
project states, 77
Configured simulation, 21
Configuring simulation
run/stop options, 78
Conflicting actions in a sequence, 138
Control view
push button use and behavior, 106
Copy protection, 23
CPU
changing the CPU family, 41
Customizing the workspace, 59, 65
Cycle time settings, 55
Cyclic event overflow error, 153

D
Data logging, 24
Device configuration, 61, 82
drag and drop to create SIM table, 102
hardware, 84
undo/redo, 86
Device configuration after download, 87
Device configuration user interface, 83
addresses section, 84
hardware configuration section, 83
Device configuration view, 85
before download, 87
Device status indicators, 85
Diagnostic errors, 23
Disabling automatic tooltip cascades, 54
Displaying tags
IO addresses, 85
Duplicate addresses in sequence, 138

E
Edit menu, 52
Edit menu commands, 50
Editor bar, 50
Editor windows, 50
Empty address field in imported file, 101, 106
Enabling automatic tooltip cascades, 54
Enabling simulation support
Know-how protection, 26, 29
Error indicator, 91
Errors in a sequence, 138
ET 200SP
Counting and measurement technology module, 30
Counting and measurement technology object, 30
Fail-Safe, 28
firmware, 28
Motion Control technology module, 30
PID Control technology module, 30
PID technology object, 30
ss technology object, 30
supported instructions, 29
technology module support, 30
technology object support, 30
Time-based IO technology module, 30
ET 200SP CPUs enabling simulation support, 29
ET 200SPF F-monitoring time, 28
supported instructions, 29
Execute menu, 53
Execute menu commands, 50
Execution editing time, 132
Execution time, 109
Export a trace
Microsoft Excel .csv file, 117
tag trace recording file, 117

F
Fail-Safe device simulation yellow coloring, 149
Fail-Safe indicator, 91
Firmware compatibility, 15
Firmware error, 15
Firmware upgrade, 15
Force indicator, 91
Forced address, 92, 107

H
Hardware in Device configuration, 84
installed with an HSP, 84
unrecognized, 84
Hardware configuration undo/redo, 84
Hardware display central/decentral, 85
Help menu commands, 50
Help system, 57
searching, 33
Help system overview, 31
HMI, 143
HMI Accessible tags, 150

I
Import only partially successful, 101, 106
Import/export in a sequence, 115
Incompatible data type in sequence, 138
Incompatible status display, 149
Incorrect parameter values, 153
Inserting a step in a sequence, 108
Installed software, 57
Invalid address in sequence, 138
IO device support, 23
IP addresses and communication, 143

K
Keyboard shortcuts, 66
Know-how protection and ET 200SP CPUs, 29
enabling simulation support, 26, 29
S7-1200 CPUs, 25

L
Language settings, 54
LEDs, 23

M
Main menu
Edit, 52
Execute, 53
Help functions, 57
help system, 57
Options > Settings, 53
Project, 51
window commands, 56
Maximum cycle time, 55
MC_Interpolator, 141
MC_Servo, 141
Memory reset, 47
Menu bar, 50, 50
Mnemonic setting, 54
Mnemonics selection, 155
Modifying a running simulation, 39
Motion control, 139
alarm 113, 142
homing mode, 140
isochronous mode error, 142
limitations, 139
maximum resources, 140
quantity structure, 140
technology objects, 139, 140
TO_ExternalEncoder, 142
TO_PositioningAxis, 141
Motion control blocks OB91 and OB92, 141
MRES, 47
Multiple instances
  copy and paste, 151

N
Naming a project, 72
New features, 11

O
Online support, 32
Online/offline status, 82
Opening projects from older versions, 38, 38
Options menu commands, 50
Overview of undo and redo, 68

P
Password protection levels
  simulation, 153
Pasting structured tags, 115
PC-based controller support, 23
Pinning the editor screen, 65
Playing a sequence created from recorded SIM table actions, 114
PLCs
  virtual vs. real, 22
Power button, 17, 18
Power cycling, 19
Prerequisites to startup, 35
PROFIBUS elements, 24
Program debugging, 107
Project
  creating a, 72
  data contained in a, 72
  file extension, 58, 72
  location, 54
  new, 58
  open, 58
  properties, 74
  save, 58
Project and compact views, 16
Project menu, 51
Project menu commands, 50
Project menu delay, 155
Project properties, 50
Project states, 75, 76
Project storage location, 72
Project tree, 50, 61
  Sequences folder, 62
  SIM tables folder, 62
Project view, 49
  input values, 12
  running configured simulation, 81
  running with unconfigured simulation, 80
  toolbar, 57
  with no simulation, 79
Project view toolbar
  CPU family selector, 59
  power setting from toolbar, 59
Projects
  opening a project, 38
  Projects vs. simulations, 16

R
Readme file, 33
Recent project list, 54
Recipes, 24
Record and playback, 114
Recording session
  ending, 122
  pausing, 122
Recording SIM table actions, 121
Renaming a sequence, 62
Renaming a SIM table, 62
Resetting to default settings, 54
RUN mode, 22
  setting from Execute menu, 53
  setting from toolbar, 59
RUN/STOP, 59
Running S7-PLCSIM on a remote desktop connection, 154

S
S7-1200
  Counting technology module, 25
  Fail-Safe, 24
  Motion Control technology module, 25
  Motion control technology object, 25
  PID Control technology module, 25
  PID technology object, 25
supported instructions, 25
  technology module support, 25
  technology object module support, 25
valid firmware versions, 24
S7-1200 CPUs
  Know-how protection, 25
S7-1200F
  F-monitoring time, 24
  supported instructions, 25
  valid firmware versions, 24
S7-1500
  Counting and measurement technology module, 27
  Counting and measurement technology object, 28
  Fail-Safe, 26
  Motion Control technology module, 27
  PID Control technology module, 27
  PID technology object, 28
  ss technology object, 28
  supported instructions, 27
  technology module support, 27
  technology object support, 28
  Time-based IO technology module, 27
S7-1500 CPUs
  and know-how protection, 26
  enabling simulation support, 26
  firmware, 26
S7-1500F
  F-monitoring time, 26
  supported instructions, 27
S7-PLCSIM
  compact and project view, 15
  compile error when downloading, 151
  opening a project, 37
  opening existing projects, 37
  simulating and debugging projects, 38
  tools menu commands, 55
S7-PLCSIM Advanced, 14
S7-PLCSIM overview, 11
S7-PLCSIM products and versions, 13
S7-PLCSIM V15
  installation setup, 12
  supported systems, 12
S7-PLCSIM V5.4.8, 13
S7-PLCSIM V5.x, 143
Save workspace settings, 65
Scan cycle overflow, 149
SD card, 23, 24, 24
Sequence
  action column, 110
  action parameter column, 110
  adding a step, 108
  address column, 110
adjusting step time, 108
auto fill, 114
auto fill and default interval, 114
comment column, 110
context menu, 111
copy and paste, 115
creating and populating, 113
creating from a trace file, 116
current step, 111
default interval, 109, 114
delaying steps, 137
disabling a step, 108
display format column, 110
editable steps, 111
enable and disable steps, 136
enabling a step, 108
error conditions, 138
error indicator, 111
execution time, 109
export to Excel, 109
features in common with SIM table, 87
import from Excel, 109
import from trace measurement, 109
import/export, 116
import/export and the time field, 116
importing a trace file, 117
indicator column, 110
inserting a step, 108
multiple steps with same address, 130
name column, 110
pasting structured tags, 115
pausing a sequence, 109
renaming, 108
repeating a sequence, 109
repeating from the toolbar button, 124
running multiple, 137
save window settings, 109
start immediately, 111
start on trigger, 111
starting a sequence, 108, 123
step timing, 131
steps, 111
stop step, 111
stopping a sequence, 108
time column, 110
time format settings, 109
toolbar, 108
trigger condition, 124
triggering a tag, 126
undo and redo, 113
undo and redo during playback, 113
visual feedback, 127
watch table entries, 116
Sequence editor
actions, 127
adding a step, 134
addresses, 107
default interval, 134
default steps, 134
deleting a step, 135
inserting a step, 134
overview, 107
Set to frequency, 128
Set to value, 128
Time, 129
time entry example, 130
Sequences
and breakpoints, 112
and HOLD mode, 112
Service and support, 32
Set to frequency, 128
Set to value, 128
Settings
cycle time, 64
overview, 62
storage, 64
SIM editor
displaying Control view, 104
table and control views, 103
Sim table
recording actions, 121, 122
SIM table editor
autofill, 97
batch modify, 99
Consistent modify, 99
copy and paste, 99
pasting structured tags, 99
recording actions to create sequence, 103
undo and redo, 96
SIM table popuation
overview, 96
Simulating a power cycle, 40
Simulating communication, 143
Simulating communications with an HMI and multiple PLCs, 152
Simulating HMI connections, 150
Simulating in standby mode, 154
Simulating motion control in run mode, 140
Simulating S7-1500
avoid forcing inputs, 152
Simulation
and the power button, 18
RUN and STOP modes, 22
Simulation errors, 149
Simulation states, 75
Simulations
configured versus unconfigured, 43
Simulations and projects actions, 75
Simulations vs. projects, 16
Slider control, 104
controlling the value range, 105
default ranges, 105
persistance behavior with cut/copy and paste, 105
persistence behavior for import and export, 105
updating values, 104
value range persistence, 105
Software programs
repairing and uninstalling, 13
Splitting the screen, 65
Start simulation command, 36
Starting a simulation, 17
Starting PLCSIM, 37
Startup options, 35
Status bar with progress display, 50
STEP 7
export a trace file, 116
STEP 7 licenses
Basic, 14
Professional, 14
STEP 7 online and diagnostic functions, 154
STOP mode, 22
setting from Execute menu, 53
setting from toolbar, 59
Index

Stop sequence time error, 138
Stopping a simulation, 17
Storage location and settings, 54
Structured tags, 116
Supported STEP 7 programs, 22
Switch to Compact view, 16
Switch to Project view, 16
Switching views, 16

T
Tags
  auto-completion tags, 90
T-Block instructions
  data buffering, 143
Technology modules, 139
Time entry
  maximum allowed, 129
  Time-based performance, 23
Title bar, 50
Toolbar
  CPU family selector, 59
  edit commands, 58
  Execute commands, 59
  power on/off buttons, 59
  project commands, 58
  Project view, 57
  record/playback commands, 60
  undo redo commands, 60
  window commands, 59
Tooltip cascades, 54
Two-instance limit, 144

U
Unconfigured simulation, 21
Undefined error in sequence, 138
Undo/redo
  interaction between, 69
Undo/redo in project view, 70
Undo/redo in project view menu, 71
Unpinning the editor screen, 65
User interface
  Project view, 49
  split windows, 56
User name, 54
Using the STEP 7 safety system library, 152

V
Valid range for set to frequency values, 153

Views
  compact, project, 63

W
Web server, 24
What's new, 11
WinCC, 143
Window menu commands, 50
Working with global libraries, 152
Working with network drives
  automatically synchronized, 155

Z
Zoom factor, 85